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Spreadsheet Link Product Description
Use MATLAB from Microsoft Excel

1-2

Spreadsheet Link connects Excel® spreadsheet software with the MATLAB® workspace,
enabling you to access the MATLAB environment from an Excel spreadsheet. With
Spreadsheet Link software, you can exchange data between MATLAB and Excel, taking
advantage of the familiar Excel interface while accessing the computational speed and
visualization capabilities of MATLAB.

Key Features

Data preprocessing, editing, and viewing in the familiar Excel environment
Sophisticated analysis of Excel data using MATLAB and application toolboxes

Delivery of Excel based applications, using MATLAB as a computational and graphics
engine and Excel as an interface

Interactive selection of available functions using the MATLAB Function Wizard
Visual interface for customization of all Spreadsheet Link preferences



Installation

Installation

In this section...

“Product Installation” on page 1-3
“Supported Excel Versions” on page 1-3
“Files and Folders Created by the Installation” on page 1-4

“After You Upgrade the Spreadsheet Link Software” on page 1-4

To use Spreadsheet Link, you must install Microsoft Excel first, and then install
Spreadsheet Link. Ensure that you use the correct MATLAB version based on the
supported version of Excel. After Spreadsheet Link is installed on your computer, you
must set up the Spreadsheet Link add-in in Excel.

Product Installation

Install the Microsoft Excel product before you install the MATLAB and Spreadsheet Link
software. To install the Spreadsheet Link add-in, follow the instructions in the MATLAB
installation documentation. Select the Spreadsheet Link check box when choosing
components to install.

Note If you have several versions of MATLAB installed on your computer, Spreadsheet
Link uses the version that you registered last.

To install the Spreadsheet Link add-in, you need administrator system privileges on the
computer. Contact your system administrator to enable these privileges.

Supported Excel Versions

Use the following table to determine the correct MATLAB version to install, based on the
version of Excel installed on your computer. Each row in the table matches the MATLAB
version with the supported versions of Excel.

MATLAB Version Excel Versions
R2016b and later 2016, 2013, 2010, 2007
R2013b 2013, 2010, 2007

1-3
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MATLAB Version Excel Versions
R2010b 2010, 2007
R2007a 2007

Files and Folders Created by the Installation

Note The MATLAB root folder, matlabroot, is where MATLAB is installed on your
system.

The Spreadsheet Link installation program creates a subfolder under matlabroot
\toolbox\. The exlink folder contains these files:

* excllink.xlam: The Spreadsheet Link add-in for Microsoft Excel

* Ex1liSamp.x1ls: Spreadsheet Link example files described in this documentation

After You Upgrade the Spreadsheet Link Software

If MATLAB and Spreadsheet Link are installed on your computer, to upgrade to a newer
version:

Install the new version of MATLAB and Spreadsheet Link.

Start MATLAB and a Microsoft Excel session.

Configure the Spreadsheet Link software. For details, see “Add-In Setup” on page 1-
6.

4 If you have existing workbooks with macros that use Spreadsheet Link, update
references to Spreadsheet Link in each workbook.

To update the references in an existing workbook in Microsoft Excel:

1 In a Microsoft Excel session, open the Visual Basic® Editor window by clicking Visual
Basic on the Developer tab. (If you do not find the Developer tab, see the Excel
Help.)

In the left pane, select a module for which you want to update a reference.
From the main menu, select Tools > References.

In the References dialog box, select the SpreadsheetLink2007_2010 check box.



See Also

5 Click OK.

See Also

More About
. “Add-In Setup” on page 1-6
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Add-In Setup

In this section...

“Configure Microsoft Excel” on page 1-6
“Work with Excel Macros” on page 1-10

“Work with Microsoft Visual Basic Editor” on page 1-11

Configure Microsoft Excel

To enable the Spreadsheet Link add-in, start a Microsoft Excel session and follow these
steps.

If you use Microsoft Excel 2007:

1 —

) o/ . )
Click ——", the Microsoft Office button.
2 Click Excel Options. The Excel Options dialog box opens.

If you use Microsoft Excel 2010 and later versions:

1 Select File from the main menu.

2 Click Options. The Excel Options dialog box opens.
The next steps are the same for both versions:

Click Add-Ins.
From the Manage selection list, choose Excel Add-Ins.
Click Go. The Add-Ins dialog box opens.

Click Browse.

aua A W N =

Select matlabroot\toolbox\exlink\excllink.xlam. (matlabroot returns the
full path to the folder where MATLAB is installed.)

6 Click Open. In the Add-Ins dialog box, the Spreadsheet Link for use with
MATLAB and Excel check bhox is selected.
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o )

Add-Ins [~ B[]

Add-Ins available:

("] Analysis ToolPak > oK
[] Analysis ToolPak - VBA
[ Euro Currency Taols Cancel
["] solver add-in

Spreadsheet Link 3.2.5 for use with MATLAE and Excel

Browse...

ik

Automation...

Spreadsheet Link 3.2.5 for use with MATLAE and Excel
Spreadsheet Link 3.2.5 for use with MATLAE and Excel

7  Click OK to close the Add-Ins dialog box.
8 Click OK to close the Excel Options dialog box.

The Spreadsheet Link add-in loads now and with each subsequent Excel session.

The MATLAB Command Window button appears on the Microsoft Windows® taskbar.

The MATLAB group appears on the top right of the Home tab in your Excel worksheet.
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Send data to MATLAE

Send named ranges to MATLAR
et data from MATLAE

Run MATLAE command

et MATLAE figure

MATLAE Function YWizard

Preferences

Spreadsheet Link is ready for use.

Right-click a cell to list the MATLAB options.



Add-In Setup
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Note If the options are missing from the context menu and if the Trust Center dialog box
has the Require Application Add-ins to be signed by Trusted Publisher check box
selected, then you must click the Enable Content button for every session.

To check the settings in the Trust Center dialog box:

1 Click the Developer tab.

2 In the Code group, click the Macro Security button. The Trust Center dialog box
opens.

3 Click Add-ins.

Work with Excel Macros

To work with Excel macros, follow these steps to enable the Developer tab on the Excel
ribbon.

If you use Microsoft Excel 2007:

1 —
(Dl

Click =, the Microsoft Office button.
2 Click Excel Options. The Excel Options dialog box opens.

If you use Microsoft Excel 2010 and later versions:

1 Click the File menu.
2 Click Options. The Excel Options dialog box opens.

The next steps are the same for both versions:

1 Click Customize Ribbon.

2 From the Main Tabs list, select Developer and click OK. The Excel ribbon displays
the Developer tab.

3 Inthe Code section of the Developer tab, click Macros. The Macro dialog box
opens. Use this dialog box to run existing macros, create macros, and edit and delete
macros.



See Also

Work with Microsoft Visual Basic Editor

To enable Spreadsheet Link as a Reference in the Microsoft Visual Basic Editor:

1  Open a Visual Basic session. Click the Visual Basic button on the Developer tab, or
press Alt+F11.

Note For instructions about displaying the Developer tab, see Excel Help.

In the Visual Basic toolbar, select Tools > References.

In the References — VBA Project dialog box, select the SpreadsheetLink or
SpreadsheetLink2007_2010 check box.

4 Click OK.

See Also

matlabroot

More About

. “Installation” on page 1-3
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Setting Spreadsheet Link Preferences

1-12

In this section...

“Preferences Dialog Box” on page 1-12
“Preferences in Worksheet Cells” on page 1-13

To control how Spreadsheet Link and MATLAB behave when Spreadsheet Link starts

MATLAB in Microsoft Excel, you can set preferences with the Preferences dialog box or
within individual worksheet cells.

Preferences Dialog Box

1 Click Preferences in the MATLAB group. The MATLAB group appears to the top
right of the Home tab in your Excel worksheet.



Setting Spreadsheet Link Preferences

o =)

Preferences @

[~ iStart MATLAB at Excel startup!

MATLAE program id

| 9.0

MATLAE startup folder

E -

[™ Use MATLAE desktop

[~ Show MATLAE errors

r Force use of MATLAB cell arrays with
MLPutMatrix

[ Treat mizsing/empty cells as MaM

QK Cancel

2 Set your preferences by selecting check boxes and filling in the text boxes. For the
MATLAB program id, enter the MATLAB version as shown in the Windows registry.
For the MATLAB startup folder, enter the full path of the startup folder.

Preferences in Worksheet Cells

To set a preference in a worksheet cell in Microsoft Excel, enter text that runs the
corresponding Spreadsheet Link function in the worksheet cell. For example, to set the
MATLAB version in a worksheet cell:

1  Set the MATLAB version to 9.0, which corresponds to MATLAB R2016a, by entering
this text.

=MLProgramId("9.0")
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A B
1 |:MLPngramld|{”5.D“}|

2 To run the function, press enter.

For details, see MLProgramId.

See Also
MLPutMatrix

More About

. “Worksheet Cell Errors” on page 3-2
. “Startup Errors” on page 3-13
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Start and Stop Spreadsheet Link and MATLAB

In this section...

“Start Spreadsheet Link and MATLAB Automatically” on page 1-15
“Start Spreadsheet Link and MATLAB Manually” on page 1-15
“Connect to an Already Running MATLAB Session” on page 1-15
“Specify the MATLAB Startup Folder” on page 1-16

“Stop Spreadsheet Link and MATLAB” on page 1-17

Start Spreadsheet Link and MATLAB Automatically

When installed and configured according to the instructions in “Add-In Setup” on page 1-
6, the Spreadsheet Link and MATLAB software automatically start when you start a
Microsoft Excel session.

Start Spreadsheet Link and MATLAB Manually

1 Select Tools > Macro.
* In Excel 2007, click the View or Developer tab, and then click the Macros
button.

* In Excel 2010, click the View menu and select Macros on the Excel toolstrip, and
then click View Macros.

Enter matlabinit into the Macro Name/Reference field.

Click Run. The MATLAB Command Window button appears on the Microsoft
Windows taskbar.

Connect to an Already Running MATLAB Session

By default, Spreadsheet Link starts a new MATLAB session. Alternatively, it can connect
to an already running MATLAB session.

Note If several versions of MATLAB are installed on your computer, Spreadsheet Link
always uses the last registered version. If you try to connect to an already running
MATLAB session that is not the last registered version, Spreadsheet Link starts a new
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MATLAB session. Spreadsheet Link does not connect to the existing one. To change the
last registered version, see “Startup Errors” on page 3-13.

To connect a new Excel session to an already running MATLAB session:
1 [n MATLAB, enter the following command:

enableservice('AutomationServer',true)

This command converts a running MATLAB session into an Automation server.
2 Start a new Excel session. It automatically connects to the running MATLAB session.

Alternatively, you can start MATLAB as an automation server from the beginning. To start
MATLAB as an automation server, use the automation command-line option:

matlab -automation

This command does not start MATLAB in a full desktop mode. To do so, use the -desktop
option:

matlab -automation -desktop

If you always use MATLAB as an automation server, modify the shortcut that you use to
start MATLAB:

1  Right-click your MATLAB shortcut icon. (You can use the icon on your desktop or in
the Windows Start menu.)
Select Properties.
Click the Shortcut tab.

Add -automation in the Target field. Remember to leave a space between
matlab.exe and -automation.

5 Click OK.

For details, see “Manually Create Automation Server” (MATLAB).

Specify the MATLAB Startup Folder

MATLAB starts in the MATLAB root folder and completes the initialization. After starting,
MATLAB changes to the Spreadsheet Link MATLAB startup folder. For details about
specifying the startup folder, see MLStartDir.



Start and Stop Spreadsheet Link and MATLAB

Stop Spreadsheet Link and MATLAB

If you started the Spreadsheet Link and MATLAB software from the Excel interface:

* To stop both the Spreadsheet Link and MATLAB software, close the Excel session as
you normally would.

» To stop the Spreadsheet Link and MATLAB software and leave the Excel session
running, enter the =MLClose () command into an Excel worksheet cell. You can use
the MLOpen or matlabinit function to restart the Spreadsheet Link and MATLAB
sessions manually.

If you connected an Excel session to an existing MATLAB session, close Excel and
MATLAB sessions separately. Closing one session does not automatically close the other.

1-17
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Create Diagonal Matrix Using Microsoft Excel Ribbon

This example shows how to execute Spreadsheet Link functions to export a named range
in a worksheet to MATLAB and create a diagonal matrix using the Microsoft Excel ribbon.

The MATLAB group on the Microsoft Excel ribbon contains commands for common
Spreadsheet Link functions. For the list of common functions, see “Executing Spreadsheet
Link Functions” on page 1-42.

This example assumes that MATLAB is running after Microsoft Excel opens. For starting
MATLAB, see “Start and Stop Spreadsheet Link and MATLAB” on page 1-15.

In a worksheet, enter the numbers 1 through 5 into the range of cells from Al through
E1l. Define the name testData for this range of cells and select it. For instructions, see
Excel Help and enter the search term: define and use names in formulas.

The named range testData appears in the Name Box.

testData - Je 1

A B C D E
1 1 2 3 1 5

On the Home tab of the Microsoft Excel ribbon, click the MATLAB group in the top-right
corner. Then, select Send named ranges to MATLAB. When you select this command,
the software executes MLPutRanges.

1-18



Create Diagonal Matrix Using Microsoft Excel Ribbon

o B A
ort & Find &
ilter = Seleck -
19 |\ Start MATLAE

Send data to MATLAE

-

Send named ranges to MATLAR
et data from MATLAE

Run MATLAE command

et MATLAE figure

MATLAE Function YWizard
Preferences

Microsoft Excel exports the named range testData into the MATLAB variable testData
in the MATLAB workspace.

Comrmand Windoa @ | Workspace @
(@) Mew to MATLABT Watch this Video, see Exarnples, orre | Mame Walue hin hax
»> testData [ testData [123,45] 1 5
testhata =
1 2 3 4 =1
fr >

Select the MATLAB group option Run MATLAB Command. When you select this
command, Microsoft Excel displays a dialog box. Next, create a diagonal matrix. Use the
diag function to specify testData as the input argument and d as the output argument.
Enter this MATLAB command in the dialog box and click OK.

d = diag(testData)

The software executes the MLEvalString function. The MATLAB variable d appears in
the MATLAB workspace and contains a diagonal matrix.

1-19
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Retrieve the diagonal matrix into the worksheet by selecting cell A3. Select the MATLAB
group option Get data from MATLAB. When you select this command, Microsoft Excel
displays a dialog box. Retrieve the diagonal matrix in d by entering d in the dialog box
and clicking OK. The software executes the MLGetMatrix function.

The diagonal matrix displays in cells A3 through E7.

A E C D E

1 1 2 3 4 3
2

3 | 1.| 0 0 0 o
4 0 2 0 0 0
3 0 0 3 0 o
& 0 0 0 4 0
7 0 0 0 0 3

See Also
MLEvalString | MLGetMatrix | MLPutRanges

More About

. “Create Diagonal Matrix Using Microsoft Excel Context Menu” on page 1-21
. “Create Diagonal Matrix Using Worksheet Cells” on page 1-25

. “Create Diagonal Matrix Using VBA Macro” on page 1-28

. “Executing Spreadsheet Link Functions” on page 1-42
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Create Diagonal Matrix Using Microsoft Excel Context
Menu

This example shows how to execute Spreadsheet Link functions to export a named range
in a worksheet to MATLAB and create a diagonal matrix using the Microsoft Excel context
menu.

The MATLAB group menu in the Microsoft Excel context menu contains commands for
common Spreadsheet Link functions. For the list of common functions, see “Executing
Spreadsheet Link Functions” on page 1-42.

This example assumes that MATLAB is running after Microsoft Excel opens. For details,
see “Start and Stop Spreadsheet Link and MATLAB” on page 1-15.

In a worksheet, enter the numbers 1 through 5 into the range of cells from Al through
E1l. Define the name testData for this range of cells and select it. For instructions, see
Excel Help and enter the search term: define and use names in formulas.

The named range testData appears in the Name Box.

testData - Je 1

A B C D E
1 1 2 3 1 5

To find the command that exports the named range to MATLAB, right-click another cell
outside of the named range in the worksheet. The Microsoft Excel context menu appears.
To see the MATLAB group menu, select MATLAB.
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Select Send named ranges to MATLAB. When you select this command, the software
executes MLPutRanges.
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Create Diagonal Matrix Using Microsoft Excel Context Menu

Microsoft Excel exports the named range testData into the MATLAB variable testData
in the MATLAB workspace.

Caornrmand YWindo ) \Workspace )]
'/?' e to MATLABT Watch this Video, see Exarnples, orre | Mame Walue Wi M

=» testData 1 testData [1,2,3,45] 1 5

testhata =

Select the MATLAB group option Run MATLAB Command. When you select this
command, Microsoft Excel displays a dialog box. Next, create a diagonal matrix. Use the
diag function to specify testData as the input argument and d as the output argument.
Enter this MATLAB command in the dialog box and click OK.

d = diag(testData)

The software executes the MLEvalString function. The MATLAB variable d appears in
the MATLAB workspace and contains a diagonal matrix.

Retrieve the diagonal matrix into the worksheet. First select cell A3, and then select the
MATLAB group option Get data from MATLAB > d. The software executes the
MLGetMat rix function.

The diagonal matrix displays in cells A3 through E7.
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A E C D E

1 1 2 3 4 5
2

3 | 1.| 0 0 0 0
4 0 2 0 0 0
> 0 0 3 0 0
5] 0 0 0 4 0
7 0 0 0 0 5

See Also
MLEvalString | MLGetMatrix | MLPutRanges

More About

. “Create Diagonal Matrix Using Microsoft Excel Ribbon” on page 1-18
. “Create Diagonal Matrix Using Worksheet Cells” on page 1-25

. “Create Diagonal Matrix Using VBA Macro” on page 1-28

. “Executing Spreadsheet Link Functions” on page 1-42
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Create Diagonal Matrix Using Worksheet Cells

This example shows how to execute Spreadsheet Link functions to export a named range
in the worksheet to MATLAB and create a diagonal matrix using Microsoft Excel
worksheet cells.

The example assumes that MATLAB is running after Microsoft Excel opens. For details,
see “Start and Stop Spreadsheet Link and MATLAB” on page 1-15.

In a worksheet, enter the numbers 1 through 5 into the range of cells from Al through
El. Define the name testData for this range of cells and select it. For instructions, see
Excel Help and enter the search term: define and use names in formulas.

The named range testData appears in the Name Box.

testData - Fe 1

A B C D E
1 1 2 3 1 s

Enter the Spreadsheet Link function MLPutRanges directly into the worksheet cell as a
worksheet formula. Double-click cell A3. Enter this text.

=MLPutRanges ()

Press Enter. Microsoft Excel exports the named range testData into the MATLAB
variable testData in the MATLAB workspace. After a Spreadsheet Link function
successfully executes as a worksheet formula, the cell contains the value 0. While the
function executes, the cell shows the entered formula.
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Corarmand Window ™ Mdorkspace @
'? Mew to MATLABT Wifatch this Video, see Examples, orre | Mame Walue rin Pl
> testData ] testData [1,2,3,4,5] 1 5
testData =
1 2 3 4 5
fx owx

Double-click cell A5. Next, create a diagonal matrix. Use the diag function to specify
testData as the input argument and d as the output argument. The Spreadsheet Link
function MLEvalString executes the MATLAB command. Enter this text.

=MLEvalString("d = diag(testData);")

Press Enter. MATLAB executes the diag function. The MATLAB variable d appears in the
MATLAB workspace and contains the diagonal matrix.

Double-click cell A7. Now retrieve the diagonal matrix into the worksheet using the
Spreadsheet Link function MLGetMatrix. Enter this text.

=MLGetMatrix("d","A9")

The diagonal matrix displays in cell A9 through E13.
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A B C D E
1 1 2 3 4 5
2
3 0
4
2 0
&
7 0
8 :I
2! 1 0 0 0 0
10 ] 2 ] ] 0
11 0 0 3 0 0
12 ] ] ] 4 0
13 0 0 0 0 5

See Also

MLEvalString | MLGetMatrix | MLPutMatrix | MLPutRanges

More About

. “Create Diagonal Matrix Using Microsoft Excel Ribbon” on page 1-18

. “Create Diagonal Matrix Using Microsoft Excel Context Menu” on page 1-21
. “Create Diagonal Matrix Using VBA Macro” on page 1-28

. “Executing Spreadsheet Link Functions” on page 1-42
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Create Diagonal Matrix Using VBA Macro
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This example shows how to execute Spreadsheet Link functions to export a named range
in the worksheet to MATLAB and create a diagonal matrix using a Microsoft Excel VBA
macro.

The example assumes that MATLAB is running after Microsoft Excel opens. For details,
see “Start and Stop Spreadsheet Link and MATLAB” on page 1-15.

In a worksheet, enter the numbers 1 through 5 into the range of cells from Al through
E1l. Define the name testData for this range of cells and select it. For instructions, see
Excel Help and enter the search term: define and use names in formulas.

The named range testData appears in the Name Box.

testData - Je 1

A = C D E

On the Developer tab in Microsoft Excel, click Visual Basic. The Visual Basic Editor
window opens.

Insert a new module and create a diagonal matrix from the data in testData. To insert
the module, select Insert > Module. In the Code section, enter this VBA code that
contains a macro named Diagonal.

Sub Diagonal()
MLPutRanges
MLEvalString "b = diag(testData);"
MLGetMatrix "b", "A3"
MatlabRequest

End Sub

The Diagonal macro exports the named range into the MATLAB variable testData
using the MLPutRanges function. Then, the macro uses the MLEvalString function to
execute MATLAB code. The MATLAB code creates a diagonal matrix from the data in
testData using the diag function. The code assigns the diagonal matrix to the MATLAB
variable b. Then, the macro uses the MLGetMat rix function to import the diagonal
matrix into the worksheet.



See Also

Copy and paste the code into the Visual Basic Editor from the HTML version of the
documentation.

For details about working with modules, see Excel Help.

Run the macro by clicking Run Sub/UserForm (F5). For details about running macros,
see Excel Help.

The diagonal matrix displays in the worksheet cells A3 through E7.

A E C D E

1 1 2 3 4 5
2

3 | 1.| 0 0 0 0
4 0 2 0 0 0
3 0 0 3 0 0
6 0 0 0 4 0
7 0 0 0 0 5

See Also
MLEvalString | MLPutRanges | diag

More About

. “Create Diagonal Matrix Using Microsoft Excel Ribbon” on page 1-18

. “Create Diagonal Matrix Using Microsoft Excel Context Menu” on page 1-21
. “Create Diagonal Matrix Using Worksheet Cells” on page 1-25

. “Executing Spreadsheet Link Functions” on page 1-42
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Find and Execute MATLAB Function Using MATLAB
Function Wizard

1-30

This example shows how to find and execute the triu function using the MATLAB

Function Wizard for Spreadsheet Link. You can use the Function Wizard to find any
MATLAB function.

First, open the MATLAB Function Wizard from Microsoft Excel. From the Home tab,
select the MATLAB group option MATLAB Function Wizard. Locate the triu MATLAB
function, choose the function signature, and then execute it.



Find and Execute MATLAB Function Using MATLAB Function Wizard

1. Select a category:

I matablelmat - Elementary matrices and matrix manipj Update |

2. Select a function:

ril i
frue —
vander ;I

3. Select a function signature:

TRIUX)

TRIU(K,K)
triu

Function Help:

TRIL Extract upper triangular part.
TRIU(X) is the upper triangular part of X,
TRIU(X K] is the elements on and above the K-th diagonal of
¥, K =0is the main diagonal, K = 0is above the main
diagonal and K < 0 is below the main diagonal.

See also TRIL, DIAG,

\_P_ »

MATLAR Function Wizard

Alternatively, you can execute the function in a Microsoft Excel worksheet cell by using

Spreadsheet Link function matlabfcn or matlabsub.

List Folders and Function Categories

All folders or categories in the current search path appear in the Select a category field
of the MATLAB Function Wizard. Click an entry to select it. Each entry in the list appears

as a folder path and a description read from the Contents.m file in that folder. If no
Contents.mfile is found, the category list displays contains this message:
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finance\ finsupport -(No table of contents file)
Refresh and Select Category
Click Update to refresh the category list. For details about the search path, see path.

The Select a function field displays a list of available functions for that category. Click
the function name you want to execute. For help with the selected function, view the
Function Help field.

Select Function Signature and Enter Formula

The Select a function signature field displays available signatures for that function.
Click a function signature to select it. The Function Arguments dialog box appears.

-

Function &rguments @
TRIU Inputs: - |

Optional output cell(s): | J
TRIU Extract upper triangular part. “
TRIU(X) is the upper triangular part of X,

TRIU(X,K) is the elements on and above the K-th diagonal of
¥, K =0is the main diagonal, K = 0 is above the main
diagonal and K < 0 is below the main diagonal. j

oK | ‘Cancel ;

Specify the worksheet cell that contains the input argument X. By default, the output of
the selected function appears in the current worksheet cell using the Spreadsheet Link
function matlabfcn.

See Also
matlabfcn | matlabsub



See Also

More About
. “Find Custom MATLAB Function Using MATLAB Function Wizard” on page 1-34
. “Executing Spreadsheet Link Functions” on page 1-42
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Find Custom MATLAB Function Using MATLAB Function
Wizard

1-34

This example shows how to write a custom function and find it using the MATLAB
Function Wizard for Spreadsheet Link. To execute MATLAB functions using the MATLAB
Function Wizard, see “Find and Execute MATLAB Function Using MATLAB Function
Wizard” on page 1-30.

Create and save a custom function in MATLAB. First, create a help header in the function
that contains supported function signatures to use with the MATLAB Function Wizard.
Write the function that calculates the Fibonacci numbers, and then save the function in
the folder Documents\MATLAB.

function f = fibonacci(n)
FIBONACCI(N) Calculate the Nth Fibonacci number.
N must be a positive integer.

%
%

ifn<®0
error('Invalid number."')
elseif n ==
f=0;
elseif n ==1
f=1;
else
f = fibonacci(n - 1) + fibonacci(n - 2);
end;

end
For writing MATLAB functions, see “Create Functions in Files” (MATLAB).

Add the folder where you saved the function to the MATLAB search path. You can use the
pathtool function or select Set Path in the MATLAB Toolstrip.

Open the MATLAB Function Wizard in Microsoft Excel using either the Microsoft Excel
ribbon or context menu. Select the folder where you saved your function.



See Also

MATLAR Function Wizard ==

oo

1. Select a category:

I Documents MATLAB - (Mo table of contents file) j Update |

2. Select a function:
fibonacd

3. Select a function signature:

FIBONACCI(N)
fibonacc

Function Help:

FIBOMACCI(MN) Compute the Mth Fibonacd number.,
M must be a positive integer.

Ok |

To execute this function, follow the steps in “Find and Execute MATLAB Function Using
MATLAB Function Wizard” on page 1-30.

See Also
matlabfcn | matlabsub
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More About
. “Find and Execute MATLAB Function Using MATLAB Function Wizard” on page 1-30
. “Executing Spreadsheet Link Functions” on page 1-42
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Return Multiple Output Arguments from MATLAB Function

Return Multiple Output Arguments from MATLAB
Function

This example shows how to execute a MATLAB function that returns multiple output
arguments in Microsoft Excel using a Microsoft Excel VBA macro. The macro writes
multiple output arguments from the MATLAB workspace to Microsoft Excel cells.

This example calculates the singular value decomposition of a matrix using svd.
In the Microsoft Excel cells from Al through C3, create a range of data. Enter numbers

from 1 through 3 in cells Al through A3. Enter numbers from 4 through 6 in cells Bl
through B3. Enter numbers from 7 through 9 in cells C1 through C3.

X - Je 1
A B C D
1 1 2 3
2 4 5
3 7 a8 9
=
4

Create a Microsoft Excel VBA macro named applysvd. For details about creating
macros, see Excel Help.

Public Sub applysvd()

MLOpen
MLPutMatrix "x", Range("Al:C3")
MLEvalString ("[u,s,v] = svd(x);")
MLGetMatrix "u", "A5"
MLGetMatrix "s", "A9"
MLGetMatrix "v", "A13"
MatlabRequest
MLClose

End Sub

The macro:

1 Starts MATLAB.
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2 Sends the data in the Al through C3 cell range to the MATLAB workspace and
assigns it to the MATLAB variable x.

3 Runs svd with the input argument x and output arguments u, s, and v.

Individually retrieves data for one output argument into a specific Microsoft Excel
cell while accounting for the size of each output data matrix to avoid overwriting
data. For the first output argument, the macro retrieves the data for the output
argument u into cell A5.

5 Closes MATLAB.

Run applysvd. MATLAB runs svd and populates the specified cells with data from the
three output arguments.

A5 - f
A B C

1 1 2 3

2 4 5

3 7 3 9

4

5 | -D.2148_| 0.8872  0.4082

6 | -0.5206 0.2496 -0.8165

7 | -0.8263 -0.3879  0.4082

8

9 | 16.8481 0.0000  0.0000

10| 0.0000 1.0684  0.0000

11| 0.0000 0.0000  0.0000

12

13 -0.4797  -0.7767 0.4082
14 -0.5724  -0.0757  -0.8165
15 -0.6651 0.6253 0.4082
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For details about running macros, see Excel Help.

See Also
MLClose | MLEvalString | MLGetMatrix | MLOpen | MLPutMatrix | svd

More About

. “Create Diagonal Matrix Using VBA Macro” on page 1-28
. “Executing Spreadsheet Link Functions” on page 1-42
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Convert Dates Between Microsoft Excel and MATLAB

1-40

Default Microsoft Excel date numbers represent the number of days that have passed
since January 1, 1900. For example, January 1, 1950 is represented as 18264 in the Excel
software.

However, MATLAB date numbers represent the number of days that have passed since
January 1, 0000, so January 1, 1950 is represented as 712224 in the MATLAB software.
Therefore, the difference in dates between the Excel software and the MATLAB software
is a constant, 693960 (712224 minus 18264).

To use date numbers in MATLAB calculations, apply the 693960 constant as follows:

e Add it to Excel date numbers that are read into the MATLAB software.
* Subtract it from MATLAB date numbers that are read into the Excel software.

Note If you use the optional Excel 1904 date system, the constant is 695422.

Dates are stored internally in the Excel software as numbers and are unaffected by locale.

See Also

Related Examples
. “Create Diagonal Matrix Using Worksheet Cells” on page 1-25
. “Create Diagonal Matrix Using VBA Macro” on page 1-28



Localization Information

Localization Information

This document uses Microsoft Excel with an English (United States) Microsoft
Windows regional setting for illustrative purposes. If you use Spreadsheet Link with a
non-English (United States) Windows desktop environment, certain syntactical
elements might not work as illustrated. For example, you might have to replace the
comma delimiter within Spreadsheet Link commands with a semicolon or other operator.

Please consult your Windows documentation to determine which regional setting
differences exist among non-US versions.

See Also

Related Examples
. “Setting Spreadsheet Link Preferences” on page 1-12
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Executing Spreadsheet Link Functions

1-42

Spreadsheet Link functions manage the connection and data exchange between Microsoft
Excel and MATLAB, without leaving the Microsoft Excel environment.

To execute Spreadsheet Link functions, you must:

* Understand the differences between these functions and Microsoft Excel functions.

* Choose the right function type, execution method, and calculation mode for your
situation.

* Decide how to specify functions and arguments.

Spreadsheet Link and Microsoft Excel Function Differences

In Microsoft Excel, entering Spreadsheet Link functions can be similar to Microsoft Excel
functions. The differences include:

* Spreadsheet Link functions perform an action, while Microsoft Excel functions return
a value.

* Spreadsheet Link function names are case-insensitive. Entering either MLPutMat rix
or mlputmatrix executes the MLPutMatrix function.

* MATLAB function names and variable names are case-sensitive. For example, BONDS,
Bonds, and bonds are three different MATLAB variables.

Spreadsheet Link Function Types
There are link management and data management functions in Spreadsheet Link.

Link management functions initialize, start, and stop the Spreadsheet Link and MATLAB
software. Execute the matlabinit function from the Excel Tools > Macro menu or in
macro subroutines.

Data management functions copy data between Microsoft Excel and the MATLAB
workspace. These functions execute MATLAB commands in Microsoft Excel. Except for
MLPutVar and MLGetVar, you can execute any data management function as a
worksheet cell formula or in a VBA macro. The MLPutVar and MLGetVar functions
execute only in VBA macros.



Executing Spreadsheet Link Functions

Spreadsheet Link Function Execution Method

You can execute Spreadsheet Link functions using these various methods.

Execution Method Advantages Limitations

Microsoft Excel ribbon Quickly access common Full Spreadsheet Link
Spreadsheet Link functionality is unavailable.
functionality in the MATLAB
group:

* matlabinit

* MLPutMatrix
* MLPutRanges
* MLGetMatrix
* MLEvalString
* MLGetFigure

¢ MATLAB Function
Wizard (For details, see
“Find and Execute
MATLAB Function Using
MATLAB Function
Wizard” on page 1-30.)

¢ Preferences (For details,
see “Setting Spreadsheet
Link Preferences” on
page 1-12.)
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Execution Method

Advantages

Limitations

Microsoft Excel context
menu

Quickly access common
Spreadsheet Link
functionality in a worksheet
cell:

* MLPutMatrix
* MLPutRanges
* MLEvalString

* MLGetFigure

 MATLAB Function
Wizard (For details, see
“Find and Execute
MATLAB Function Using
MATLAB Function
Wizard” on page 1-30.)

e MLGetMatrix

Full Spreadsheet Link
functionality is unavailable.

Microsoft Excel worksheet
cell

Execute any Spreadsheet
Link function.

¢ Execute MATLAB
functions.

You cannot execute
MLGetVar, MLPutVar, or
matlabinit within a
worksheet cell.

Microsoft Excel VBA macro

Execute any Spreadsheet
Link function.

¢ Execute MATLAB
functions.

¢ Execute advanced VBA
code.

Requires knowledge of
Microsoft Visual Basic.




Executing Spreadsheet Link Functions

Execution Method Advantages Limitations

MATLAB Function Wizard e Find MATLAB function |Execute a MATLAB function

by category or folder. using only the Spreadsheet
o Explore MATLAB Link functions matlabfcn
and matlabsub.

function syntaxes.

* Execute MATLAB
function by choosing a
syntax and specifying
arguments.

* Execute custom MATLAB
function.

Specify Spreadsheet Link Function in Microsoft Excel

When you specify a Spreadsheet Link function in a worksheet cell, enter the formula by
starting with a + or = sign. Then, enclose function arguments in parentheses. This
example formula uses the MLPutMatrix function to export data in cell C10 into matrix A.

=MLPutMatrix("A",C10)

In VBA macros, leave a space between the function name and the first argument. Do not
use parentheses.

MLPutMatrix "A",C10

To change the active cell when an operation completes, select Excel Tools Options >
Edit > Move Selection after Enter. This action provides a useful confirmation for
lengthy operations.

Set Calculation Mode

Spreadsheet Link functions are most effective in automatic calculation mode. To automate
the recalculation of a Spreadsheet Link function, add a cell reference to a cell whose
value changes. For example, the MLPutMatrix function executes again when the value in
cell C1 changes.

=MLPutMatrix("bonds", D1:G26) + C1

To use MLPutMatrix in manual calculation mode:
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1 Enter the function into a cell.

2 Press F2.

3 Press Enter. The function executes.

Spreadsheet Link functions do not automatically adjust cell addresses. If you use explicit
cell addresses in a function, edit the function arguments to reference a new cell address
when you:

* Insert or delete rows or columns.

* Move or copy the function to another cell.

Specify Spreadsheet Link Function Arguments

You can specify arguments in Spreadsheet Link functions using the variable name or by
referencing the data location for the argument.

Note: Spreadsheet Link functions expect the default reference style (A1) worksheet cell
references. The columns must be designated with letters and the rows with numbers. If
your worksheet shows columns designated with numbers instead of letters, then follow
this procedure:

1  Select Tools > Options.
2 (Click the General tab.
3 Under Settings, clear the R1C1 reference style check box.

Variable-Name Arguments

* You can directly or indirectly specify a variable-name argument in most Spreadsheet
Link functions.

* To specify a variable name directly, enclose it in double quotation marks, for
example, =MLDeleteMatrix("Bonds").

* To specify a variable name as an indirect reference, enter it without quotation
marks. The function evaluates the contents of the argument to retrieve the variable
name. The argument must be a worksheet cell address or range name; for example,
=MLDeleteMatrix(C1).



Executing Spreadsheet Link Functions

Note Spreadsheet Link functions do not support global variables. When exchanging data
between Excel and MATLAB, the software uses the base workspace. Variables in the base
workspace exist until you clear them or end your MATLAB session.

Data-Location Arguments

A data-location argument must be a worksheet cell address or range name.

Do not enclose a data-location argument in quotation marks (except in MLGetMatrix,
which has unique argument conventions).

A data-location argument can include a worksheet number such as Sheet3!B1:C7 or
Sheet2!0UTPUT.

Tip: You can reference special characters as part of a worksheet name in
MLGetMatrix or MLPutMatrix by enclosing the worksheet name within single
quotation marks (' ").

Specify MATLAB Function in MATLAB Function Wizard

After you find the MATLAB function or custom function in the MATLAB Function Wizard,
you can specify the syntax and arguments. Then, Spreadsheet Link specifies this
command for evaluation in the MATLAB workspace.

To execute a MATLAB function with multiple outputs, specify where to write the output.

Specifying a target range of cells using the Optional output cell(s) field causes the
selected function to appear in the current worksheet cell as an argument of
matlabsub. The matlabsub function includes an argument that indicates where to
write the output. For example, the data from A2 is input to the rand function and the
target cell for output is B2:

=matlabsub("rand", "Sheetl!$B$2",Sheetl!$A$2)

Although the Function Wizard lets you specify multiple output cells, it does not return
multiple outputs. If you specify a range of output cells, the wizard returns the first
output argument starting in the first output cell. For example, if a function returns two
elements a and b, and you specify Al:A2 as output cells, the Function Wizard displays
a in cell Al. The Function Wizard discards element b. If an output is a matrix, the
Function Wizard displays all elements of that matrix starting in the first output cell.
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To execute multiple MATLAB functions or use MATLAB objects, write a wrapper function.

For multiple output arguments, see “Return Multiple Output Arguments from MATLAB

Function” on page 1-37.

The Function Wizard does not allow simultaneous execution of multiple MATLAB
functions. Write a wrapper function instead. For example, to plot historical closing-
price data from Bloomberg®, enter this code in MATLAB and save it as a function.

function plotbloombergdata(s)
% plotbloombergdata is a wrapper function that connects to
Bloomberg(R), retrieves historical closing-price data for
the year 2015, and plots the prices for a given
Bloomberg(R) security s.

c = blp;

f = 'LAST PRICE';

fromdate = '01/01/2015";

todate = '12/31/2015';

d = history(c,s,f,fromdate, todate);

plot(d(:,1),d(:,2))

close(c)

0® o o of

end

For details about writing functions, see “Create Functions in Files” (MATLAB).

Microsoft Excel has no context for MATLAB objects. To work with MATLAB objects,
such as connections to service providers, write a wrapper function. The wrapper
function executes the functions that create and manipulate these objects.

See Also
MLEvalString | MLGetMatrix | MLPutMatrix | matlabfcn | matlabinit

More About

“Create Diagonal Matrix Using Microsoft Excel Ribbon” on page 1-18
“Create Diagonal Matrix Using Microsoft Excel Context Menu” on page 1-21
“Create Diagonal Matrix Using Worksheet Cells” on page 1-25

“Create Diagonal Matrix Using VBA Macro” on page 1-28

“Find and Execute MATLAB Function Using MATLAB Function Wizard” on page 1-30



See Also

“Localization Information” on page 1-41
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Solving Problems with the
Spreadsheet Link Software

* “Model Data Using Regression and Curve Fitting” on page 2-2

* “Interpolate Thermodynamic Data” on page 2-10

» “Price Stock Options Using Binomial Model” on page 2-15

* “Plot Efficient Frontier of Financial Portfolios” on page 2-19
“Map Time and Bond Cash Flows” on page 2-23



2 Solving Problems with the Spreadsheet Link Software

Model Data Using Regression and Curve Fitting

This example shows how to execute MATLAB data regression and curve fitting in
Microsoft Excel using a worksheet and a VBA macro.

The example organizes and displays the input and output data in a Microsoft Excel
worksheet. Spreadsheet Link functions copy the data to the MATLAB workspace and
execute MATLAB computational and graphic functions. The VBA macro also returns
output data to a worksheet.

Open the Ex1iSamp. x1s file and select the Sheet1 worksheet. For help finding the
ExliSamp.x1s file, see “Installation” on page 1-3.

Sheet1 of the spreadsheet contains the named range DATA, which consists of the
example data set in worksheet cells A4 through C28.

A B C D E F G H J K L
1 |Regression and Curve Fitting
2
3 DATA Spreadsheet Link Functions
4 35 207 1325 1. Transfer the data to MATLAB.
5 17 90 533 #MATLAB' <== MLPutMatrix("data".DATA)
6 43 180 1013
7 4 187 1163 2. Set up data for regression.
8 177 552 5326 #MATLAB' <== MLEvalString("y = data(:,3)")
9 57 354 2043 #MWATLAB' <== MLEvalString("e = ones(length(data),1)")
10 20 101 602 #MATLAB' <== MLEvalString("A = [e data(:,1:2)]"}
" 18 91 532
12 17 86 543 3. Compute regression coefficients.
13 35 180 1134 #MATLAB' <== MLEvalString("beta = Aly")
14 25 136 766
15 17 84 495 4. Calculate regressed result.
16 23 102 635 #MATLAB' <== MLEvalString("fit = A*beta”)
17 24 148 913
18 40 292 1591 5. Compare original data with regression results.
19 25 126 671 #MATLAB' <== MLEvalString("[y.k] = sort(y}")
20 17 88 521 #MATLAB' <== MLEvalString(“fit = fit(k)")
21 46 235 1319 #MATLAB' <== MLEvalString("'n = size(data.1)")
22 v 204 1038
23 15 68 458 6. Use MATLAB's polynomial solving functions for another curve fit.
24 85 363 2904 #MATLAB' <== MLEvalString("[p.5] = polyfit(1:n.y".5)")
25 66 300 2006 #MATLAB' <== MLEvalString("newfit = polyval(p.1:n.5)")
26 39 161 938
27 111 459 3282 7. Plot curves and add legend
28 16 80 476 EMATLAB <== MLEvalString("plot(1:n,y.'be’,1:n fit, v, 1:n,newdit.'q’); legend(data’, fit’, newfit’)")
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Model Data in Worksheet

To perform regression and curve fitting, execute the specified Spreadsheet Link functions
in worksheet cells.

1

Execute the Spreadsheet Link function that copies the sample data set to the
MATLAB workspace by double-clicking the cell E5 and pressing Enter. The data set
contains 25 observations of three variables. There is a strong linear dependence
among the observations. In fact, they are close to being scalar multiples of each
other.

Execute the functions in cells E8, E9, and E10. The Spreadsheet Link functions in
these cells regress the third column of data on the other two columns, and create:

* A single vector y containing the third-column data

* A three-column matrix A, which consists of a column of 1s followed by the rest of
the data

Execute the function in cell E13. This function calculates the regression coefficients
by using the MATLAB back slash (\) operation to solve the overdetermined system
of linear equations, A*beta = vy.

Execute the function in cell E16. MATLAB matrix-vector multiplication produces the
regressed result, fit.

Execute the functions in cells E19, E20, and E21. These functions:

a Compare the original data with fit.
b  Sort the data in increasing order and apply the same permutation to fit.
¢ Create a scalar for the number of observations.

Execute the functions in cells E24 and E25. Fit a polynomial equation to the data for
a fifth-degree polynomial. The MATLAB polyfit function automates setting up a
system of simultaneous linear equations and solutions for the coefficients. The
polyval function then evaluates the resulting polynomial at each data point to check
the goodness of the fit newfit.

Execute the function in cell E28. The MATLAB plot function graphs the original data
(blue circles), the regressed result fit (dashed red line), and the polynomial result
(solid green line).
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o =
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Since the data is closely correlated, but not exactly linearly dependent, the fit curve
(dashed line) shows a close, but not exact, fit. The fifth-degree polynomial curve
newfit is a more accurate mathematical model for the data.
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Model Data Using VBA Macro

To model the data using a VBA macro, execute the Spreadsheet Link functions in a VBA
macro.

1 Inthe Ex1iSamp.x1s file, click the Sheet2 tab. The worksheet for this example
appears.
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A B C D
Regression and Curve Fitting Macro
(See Module 1)
0 === CurveFit(DATA "AT","BT","CT")

y fiit newfit

Cell A4 calls the macro CurveFit, which you can examine in the Microsoft Visual
Basic environment.
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E Microsoft Visual Basic for Applications - ExliSamp.xls EI@
! File Edit View Inset Format Debug Run  Tools Add-Ins  Window Help Type a question for help -
EE-d 4 s pon @ B B AW - @ ez coll B
Project - ExliSamp x| :
—— 2 EdiSamp.xs - Modulel (Code) o[ -E| s
i |:General] j |:Declarations] j
E@ ExliSamp (ExliSamp.xls)
-5 Microsoft Excel Objects Tal
Sheetl (Sheet1)
Sheet2 (Sheet2)
Sheet3 (Sheet3) Function CurveFic(aData, sTargetl, =sTargetZ, sTarget3)
Sheet4 (Sheetd) "MATLABR regression and curve fitting macro
Sheets (Sheets)
Sheets (Sheets) MLPutMatrix "data"™, aData
ThisWorkbook MLEvalString "y = data(:,3}"
-5 Modules MLEvalString "n = length(y}"
‘gg Module 1 MLEvalString "e = onesin,1}"
&[0 References MLEvalString "R = [e data(:,1:2)]"
- %% Spreadsheetlink2007_2010 MLEvalString "beta = A\y"
MLEvalString "fit = A*beta"
4 | I b MIEvalString "[v,k] = sortc(y)}"™

MLEvalString "fit = fit(k)"

Properties - Modulel x| MLEvalString "[p,5] = polvfit(l:m,v',5)"

|Module1 Module j MLEvalString "newfit = polyvalip,l:n,5)'"

MLEvalString "plotil:n,y,'bo',l:n,fitc,'r:',1l:n,newfit,"'qg’
HMLGetMatrix "y", sTargetl

MModulel MLGetMatrix "fit", sTarget2

MLGetMatrix "newfit"™, s=sTarget3

Alphabetic ] Categorized |

End Function

While this module is open, ensure that the Spreadsheet Link add-in is enabled. To
enable it, see “Add-In Setup” on page 1-6. After the add-in is enabled, the Project
Explorer lists it under the References folder.

2  Execute the CurveFit macro by double-clicking the cell A4 and pressing Enter. The
macro runs the Spreadsheet Link functions. When the macro finishes, the input and
output data appears in worksheet cells A7 :C31.

* Column A contains the original data y (sorted).
* Column B contains the corresponding regressed data fit.
* Column C contains the polynomial data newfit.
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A B C D
Regression and Curve Fitting Macro
(See Module 1)

0 <== CurveFit(DATA, "AT"."BT"."CT")

y fiit newfit
1325 | 379.0475] 402.008
533 430.3099 | 515.8528
1013 | 462.4722 | 549.7114
10 1163 | 472.0222 | 543.0184
11 5326 | 501.7971] 524.5499
12 2043 | 476.7973| 513.775
13 602 467.2472 | 522.2081
14 h32 570.8968 | 254.761
15 b43 641.1212 | 611.0947
16 1134 | 743.6461| 686.9715
17 766 T67.5211| 775.6072
18 495 773.5589 ] 869.023
19 B35 1143.781 | 959.3574
20 913 1279.593 | 1040.419
21 1591 | 1201.219] 1108.636
22 671 1098.695 | 1164.812
23 51 1251.081 | 1215.276
24 | 1319 | 1478743 | 1273.275
25| 1038 | 1163.157| 1360.322
26 458 1479157 | 1507 557
27| 2904 | 2086177 1757.08
28| 2006 |2011.592]2163.358
29 938 2666.224 | 2794 475
30| 3282 | 3483.345]3733.586
iy 476 5197.796 | 5080.215

See Also
MLEvalString | MLGetMatrix | MLPutMatrix | plot | polyfit | polyval
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See Also

More About

“Interpolate Thermodynamic Data” on page 2-10

“Price Stock Options Using Binomial Model” on page 2-15
“Plot Efficient Frontier of Financial Portfolios” on page 2-19
“Map Time and Bond Cash Flows” on page 2-23

“Executing Spreadsheet Link Functions” on page 1-42
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Interpolate Thermodynamic Data

2-10

This example shows how to interpolate data using Spreadsheet Link to invoke MATLAB
functions in Microsoft Excel.

The example uses the two-dimensional data-gridding interpolation function griddata on
thermodynamic data, where volume has been measured for time and temperature values.
The griddata function finds the volume values underlying the two-dimensional time-
temperature function for a new set of time and temperature coordinates.

To organize and display the original data and the interpolated output data, you can use
Microsoft Excel worksheets.

Open the Ex1iSamp. x1s file and select the Sheet3 worksheet. For help finding the
Ex1iSamp.x1s file, see “Installation” on page 1-3.

This worksheet contains measured thermodynamic data in cell ranges A5 through A29, B5
through B29, and C5 through C29. The time and temperature values for interpolation are
in cell ranges E7 through E30 and F6 through T6, respectively.



Interpolate Thermodynamic Data

A E
Data Interpolation

Driginal Data

c ] E F G H | J K L il M [u] F ] R S T

Interpolated Values

Time Temp Volume
0.025 68.00 2504.08 Temp
0050 B80S 2535.07 Time BE.0 B35 E3.0 63.5 0.0 7.5 7.0 715 T2 2.5 730 Fich-) 4.0 4.5 5.0
0075 BA.07 256291 0.025)
0.100 68.03 2575.74 0.05]
0125 6820 260616 0.075)
0150 68.50 Z2625.56 0.1
0.17S 6885 265138 0125
0200 6322 27206 015
0.225 T0.08 27V67.52 0175
0250 V033 2815.54 0.2
0275 70.53 2324.37 0.225)
0.300 T0.85 287365 0.25]
0.325 T 238220 0.275)
0.350 Tldd 263643 0.3
0375 .82 2302.07 0.325)
0400 V233 2320.04 0.35)
0.425 T2.65 2929.35 0.375)
0450 V346 2334.23 0.4
0.475 T3.89 2938.55 0.425)
0500 V422 301293 0.45)
0525 7437 303312 0.475)
0.550 T4.55  3130.01 0.5
0575 T4ET 317324 0.525)
0600 V472 318071 0.55)
0.625 T5.00 313415 0.575)
0.5

Spreadsheet Link Functions

1. Transfer original data o MATLAR.
HMATLAE <== MLPutMatriu["Labels", 44:C4)
HMATLAE <== MLPutMatrin["%" A5 423]
HMATLAE <== MLPutMatriu["T" B5:E23)
HMATLAE <== MLPutMatrin ™" C5: C23]

2. Transferinterpolation data paints ta MATLAE.
#MATLAE <== MLPutMatrix("%a" ET:E30]
HMATLAE <== MLPutMatrin["Ta" FE: TE)

3. Execute MATLAE data interpolation function.
#MATLAE <== MLEvalStingl"[<1, TI. V1] = griddatal.T.M X2, Ta, nearest’]"]

d. Transpose output data matrix and transfer data to Excel
HMATLAE <== MLEvalStingl("lV' = V11"
HMATLAE (== MLGetMatria["W","sheet3FT")

5. Platinterpolated data and label the figure.
#MATLAE <== MLEvalStingl"surf(x], TI, ViktitlelInterpolated Data'l nlabellL abelsii: vlabelll abelsi2t) zlabelll abel={31: grid on")

1

Execute the Spreadsheet Link function that passes the Time, Temp, and Volume
labels to the MATLAB workspace by double-clicking the cell A33 and pressing Enter.

Copy the original time data to the MATLAB workspace by executing the function in
the cell A34. To copy the original temperature data, execute the function in the cell
A35. To copy the original volume data, execute the function in cell A36.

Copy the interpolation time values to the MATLAB workspace by executing the
function in cell A39. To copy the interpolation temperature values, execute the
function in cell A40.

Execute the function in cell A43. The griddata function performs two-dimensional
interpolation that generates the interpolated volume data using the inverse distance
method.
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Time

2-12

0.025)
0.05)
0.075)
0.1
0.125
0.15]
0.175
0.2
0.225)
0.25)
0.275)
0.3
0.325)
0.35]
0.375)
0.4
0.425)
0.45)
0.475)
0.5
0.525)
0.55)
0.575)
0.6

5

Transpose the interpolated volume data and copy it to the Excel worksheet by

executing the functions in cells A46 and A47. The data fills the cell range F7:T30.

Temp

58.0

58.5

Interpolated Yalues

53.0

53.5

0.0

0.5

1.0

1.5

7z.0

725

73.0

735

4.0

7.5

5.0

2504.03
2507.26
2510.83
2513.93
2515.14
251431
2511.84
250810
250337
2437.54
243166
2454.32
247771
2470.07
2452, 06
2453.70
2445.03
2436.07
2426.82
241731
2407.54
2337.51
2387.29
2376.71

263815
2635.76
263345

263134
2623.60
2628.55
Z628.85

262391

263132
263293
26734.64
2636.35
2638.00
26339.54
264033

264215

264315
264334
2644.45
2644. 77
Z2644.80
2644.56
2644.05
264325

2707.32
2704.73
2702.58
2700.70
263317
2635.02
Z2B37.25
2636.57
Z636.85
2637.25
2638.05
2633915
2700.64
270241
2704.45
2T06.75
2703.26

2711.97
2714.54
271754
272095
272414
272739
273067

2750.09
2746.66
274362
274033
273877
2736.33
2735.66
2734.79
273437
273d4.42
273491
2735.85
273722
2735.01

274113
274375
Z746.67
2743.92
279343
2757.32
276144
27TE5.73
277037
277514

278491
27739.96
277540

277127

Z7TET.61
2764.43
2762.00
276022
2793.24

2755810
Z2753.76

276112
2763.09
2765.59
2768.54

2771583
Z2775.62
2779.65
2754.06
2T86.73
273367
2735.87

2804.31
280397

285113
2846.35
2841.54
2837.66
2833.83
283035
282731
2824.65
282257
2821.05
282023
282016
282081

28221
282395
2826.33
282313
283232
2835.88
2839.75
2844.01
2845.55
28593.38
2855.49

29162
2307.00
2302.75
2836.55
2835.40
283231
2883.53
2867.26
2885.29
2863.65
288243
2881.55
2881.06
288097
288123
2862.03
2883.20
2864.75
2886.75
2858313
283193
283513
283877
230271

2340.67
2334.35
2923.64
2324.66
232007
2315.587
2312.08
2308.72
2305.80
2303.34
230133
2833.73
2838.72
283613
2838.00
2836.34
283316
230044
230213
2304.40
2307.04

2310.11
231360
291745

2361.40
2355.07
2343.03
2343.43

293814
2333.23
2928.72
2324.62
292036

231776

2315.02

2312.75

291.04
2305.52

230313
2308.37
2303.34

2310.23

29163

2313.52

2315.583

2318.72

232193
2325.67

298317
2376.69
2397051
2364 .66
235314
235397
234317
2344.75
2340.73
233713
2933.97
2331.26
2923.03
2327.29
2926.05
232533
292514
232545
2926.34
2327.71
292357
233150
2934.65
2337.89

3000.08
2333.64
2357.50
235167
297616
237033
Z2366.17
2361.71
2957.65
235397
2350.71
2347.55
234547
2343.52
234201
2340.36
2340.37
2340.24
2340.57
2341.36
2342 61
2344.30
2346.43
234533

30086.32
2333.35
2332.60
2356.05
2973.83
2373.86
2368.21
2362.59
2957.93
2353.36
2343.20
2345.45
234221
233943
293796
233542
2934.25
233367
29337
2334.34
2935.55
2337.30
293357
234235

3041.01
3034.43
3027.935
3021.43
3015.06
3008.70
300247
2336.39
2330.50
2354.56
297352
2374.53
2963.36
2365.59
2962.39
2355.55
2957.45
2356.16
2355.74
2356.22
2357.60
2355.85
2962.83
2366.66

312578
3126.43
32697
312733
327
312795
31281
F126.21
3128.25
312624
3128.18
3126.07
31270
F127.66
312730
3126.73
3126.07
3125.09
3123.85
Jl22. 46
IELET
312055
312163
3123.41

30Z6.85
303665
304632
3055.77
3085.02)
3074.08
3082.933
3031.57
3033.39
3106.19
3614
3123.583
3131.26
3136.35
314519
F151.66]
FI5T. TS
316342
3168.63
317331
317739
3180.74
3183.21
3154.53

6

Execute the function in cell A50. The MATLAB software plots and labels the

interpolated data on a three-dimensional color surface, with the color proportional to
the interpolated volume data.




Interpolate Thermodynamic Data

E Figure 1 Ellﬁlﬂ

File Edit View Insert Tools Desktop Window Help ~
DEde | M AANOUDEL-S|0H a0
Interpolated Data

3200 -

2800 -

Volume

2400
76

72 0.4
70 0.2

Temp 68 0 Time

To generate different volume values, close the figure and change the measured
thermodynamic data in cells A5:C29. Then, execute all the Spreadsheet Link
functions again. The worksheet updates with new volume rates and MATLAB
generates a new figure of the interpolated volume data.
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See Also
MLEvalString | MLGetMatrix | MLPutMatrix | griddata | surf

More About

“Model Data Using Regression and Curve Fitting” on page 2-2
“Price Stock Options Using Binomial Model” on page 2-15
“Plot Efficient Frontier of Financial Portfolios” on page 2-19
“Map Time and Bond Cash Flows” on page 2-23

“Executing Spreadsheet Link Functions” on page 1-42



Price Stock Options Using Binomial Model

Price Stock Options Using Binomial Model

This example uses the binomial model to price a stock option. The binomial model
assumes that the probability of each possible price over time follows a binomial
distribution. Price values can become either one up or one down over any short time
period. Plotting these two values over time is known as building a binomial tree. For
details about the binomial model, see “Pricing and Analyzing Equity Derivatives”
(Financial Toolbox).

The example organizes and displays the input and output data in a Microsoft Excel
worksheet. Spreadsheet Link functions copy data to a MATLAB matrix, calculate prices,
and return data to the worksheet.

Open the Ex1iSamp. x1s file and select the Sheet4 worksheet. For help finding the
Ex1iSamp.x1s file, see “Installation” on page 1-3.

This worksheet contains these named ranges:

* B4:B10 named bindata. Two cells in bindata contain formulas:

* B7 contains =5/12

* B8 contains =1/12
* B15 named asset tree.
* B23 named value tree.
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A B

1 |Binomial Qption Pricing

2

3 bindata
4 |Asset price, so 3 52.00
5 |Option exercise price, x | § 50.00
6 |Risk-free interest rate, r 10%
7 |Time to maturity, t (yrs) | 0.416667
8 |Time increment, dt 0.083333
9 | Volatility, sig 0.4
10 |Call (1) or put (0), flag 0
"

12

13

14

15 | Asset price tree, p ($)

16

17

18

19

20

21

22

23 |Option value tree, o ($

24

25

26

27

28

Start  Period 1

=512
=112

Spreadsheet Link Functions
1. Transfer data to MATLAB.
H#FMATLAB <== MLPutMatrix("b", bindata)

2. Execute MATLAB Financial Toolbox binomial option pricing function.
#MATLAB <== MLEvalString("[p, o]=binprice(b(1), b(2}. b(3), b(4), b(5), b(E). b(7))")

3. Transfer output data to Excel.
#MATLAB' === MLGetMatrix("p", "asset_tree")
#MATLAB' === MLGetMatrix("0", "value_tree")

Period 2 Period 3 Period 4 Period &

Note This example requires Financial Toolbox™, Statistics and Machine Learning
Toolbox™, and Optimization Toolbox™.

2-16

Execute the Spreadsheet Link function that copies the asset data to the MATLAB
workspace by double-clicking the cell D5 and pressing Enter.

Execute the function that calculates the binomial prices in cell D8.
Copy the price data to the worksheet by executing the functions in cells D11 and D12.

The data in the worksheet updates.



Price Stock Options Using Binomial Model

(=3 B & B =R SV Y S R

A B C D E F G H J K

Binomial Option Pricing
bindata Spreadsheet Link Functions

Asset price, so 5 52.00 1. Transfer data to MATLAB.
Option exercise price, x | $ 50.00 0 === MLPutMatrix("b", bindata)
Risk-free interest rate, r 10%
Time to maturity, t (yrs) | 0.416667]|=5/12 2. Execute MATLAB Financial Toolbox binomial option pricing function.
Time increment, dt 0.083333]=112 0 === MLEwvalString("[p. o]=binprice(b(1). b(2). b(3). b(4). b(5), b(6). b(7))")
WVolatility, sig 04
Call (1) or put (0), flag 0 3. Transfer output data to Excel.

0 === MLGetMatrix("p", "asset_tree")
0 <== MLGetMatrix("o", "value_tree")

Start Period 1 Period 2 Period 3 Periocd 4 Period 5

Asset price tree, p (§) 52000 58365  B5.509 73527 82527 92628
0 46329 52000 HB.366  BAA09 73527
0 0 41277 46329  52.000  55.365
0 0 0 36776 41277 46329
0 0 0 0 32765 36.776
0 0 0 0 0 29.192
Option value tree, o ($ 3.728 1.664 0.423 0 0 0
0 5.918 2.964 0.876 0 0
0 0 9.060 5.164 1.793 0
0 0 0 13.224 8.723 3.671
0 0 0 0 17.235 13.224
0 0 0 0 0  20.80%

The asset price tree contains these prices:

* Period 1 — The up and down prices

* Period 2 — The up-up, up-down, and down-down prices

* Period 3 — The up-up-up, up-up, down-down, and down-down-down prices

* And so on.

The option value tree gives the associated option value for each node in the price

tree. The option value is zero for prices significantly above the exercise price. Ignore
the zeros that correspond to a zero in the price tree.

You can generate different binomial prices by changing the data in the cell range B4:B10
and executing the Spreadsheet Link functions again. If you increase the time to maturity
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in cell B7 or change the time increment in cell B8, enlarge the output tree areas as

needed.

See Also

MLEvalString | MLGetMatrix | MLPutMatrix | binprice
More About

. “Model Data Using Regression and Curve Fitting” on page 2-2
. “Interpolate Thermodynamic Data” on page 2-10

. “Plot Efficient Frontier of Financial Portfolios” on page 2-19

. “Map Time and Bond Cash Flows” on page 2-23

. “Pricing and Analyzing Equity Derivatives” (Financial Toolbox)

. “Executing Spreadsheet Link Functions” on page 1-42
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Plot Efficient Frontier of Financial Portfolios

Plot Efficient Frontier of Financial Portfolios

VI Ny

n

w oo =l

This example analyzes three portfolios with given rates of return for six time periods by
executing MATLAB functions using Spreadsheet Link. In actual practice, these functions
can analyze many portfolios over many time periods, limited only by the amount of
computer memory available.

For details about the efficient frontier of financial portfolios, see “Analyzing Portfolios”
(Financial Toolbox). To learn about portfolio optimization theory, see “Portfolio
Optimization Theory” (Financial Toolbox).

The example organizes and displays the input and output data in a Microsoft Excel
worksheet. Spreadsheet Link functions copy data to a MATLAB matrix, perform
calculations using Financial Toolbox functions, and return data to the worksheet.

Open the Ex1iSamp. x1s file and select the Sheet5 worksheet. For help finding the
Ex1iSamp.x1s file, see “Installation” on page 1-3.

This worksheet contains rates of return for three different portfolios: Global, Corporate
Bond, and Small Cap.

A B C D E F G H | J

Portfolio Efﬁ cient Frontier

Global Corp.Bnd Small Cap

Rates of return Global Corp. Bnd Small Cap Risk ROR Weights

Spreadsheet Link Functions
1. Transfer data to MATLAB.

#MATLAB?
#MATLAB?

2. Execute MATLAB Financial Toolbox functions.

#MATLAB?
#MATLAB?

3. Transfer output data to Excel.

#MATLAB?
#MATLAB?
#MATLAB?

Nov-91] 7.125% 4.125% 8.375%
MNov-92] 5.125% 5.125% 3.875%
Nov-93] -1.375%  5750% 10.500%
MNov-94] 7.750% 6.000% 14.750%
Nov-95] 8.250% 6.375% -3.625%
MNov-96] 12.625% 6.125%  9.125%

=== MLPutMatrix("Labels", F3:G3)
=== MLPutMatrix("retseries” B4.09)

=== MLEvalString({"[ret, cov] = ewstats(retseries)”)
=== MLEvalString("[risk, ror, weights] = portopt(ret, cov, 20)7)

=== MLGetMatrix("risk”, "sheet5IF47)
=== MLGetMatrix("ror”, "sheet5!G4™)
=== MLGetMatrix["weights", "sheeta!H4")

4 Plot efficient frontier data and label the figure.

#MATLAB?

=== MLEvalString("portopt(ret, cov, 20); grid on; xlabel(Labels{1}); ylabel(Labels{Z})")
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2 Solving Problems with the Spreadsheet Link Software

Note This example requires Financial Toolbox, Statistics and Machine Learning Toolbox,
and Optimization Toolbox.

1 Execute the Spreadsheet Link function that transfers the plot labels for the x-axis and
y-axis to the MATLAB workspace by double-clicking the cell A15 and pressing Enter.

2 Copy the portfolio return data to the MATLAB workspace by executing the function in
the cell A16.

3 Generate efficient frontier data for 20 points along the frontier by executing the
Financial Toolbox functions in A19 and A20.

4 Copy the output data to the Excel worksheet by executing the Spreadsheet Link
functions in A23, A24, and A25.

The output data contains the highest rate of return ROR for a given risk. The output
data also contains the weighted investment in each portfolio Weights that achieves
that rate of return.

A B C D E F G H | J
1 |Portfolio Efficient Frontier
2 Global Corp. Bnd Small Cap
3 |Rates of return Global Corp. BndSmall Cap Risk ROR Weights
4 Nov-81| 7.125% 4.125% 8.375% 0.730%|] 5.643% 0.3% 96.1% 3.5%
5 Nov-92| 5.125% 5.125%  3.875% 0.760%| 5.723% 4.0% 89.7% 6.3%
B MNov-93| -1.375% 5.750% 10.500% 0.844%| 5.803% 7.7% 83.3% 9.0%
7 Nov-94| 7.750% 6.000% 14.750% 0.968%| 5.883% 11.3% T6.9% 11.8%
8 Nov-95| 8.250% @ 6.375% -3.625% 1.118%| 5.964% 15.0% 70.5% 14.5%
9 MNov-96) 12.625% 6.125%  9.125% 1.287%| 6.044% 18.7% 54.0% 17.3%
10 1.466%| 6.124% 22.3% 57.6% 20.0%
1 1.653%| 6.204% 26.0% 51.2% 22.8%
12 1.846%| 6.284% 29.7% 44.8% 25.5%
13 | Spreadsheet Link Functions 2.042%] 6.365% 33.3% 38.4% 28.3%
14 |1. Transfer data to MATLAB. 2.241%| 6.445% 37.0% 32.0% 31.1%
15 0 === MLPutMatrix("Labels", F3:G3) 2.443%| 6.525% 40.6% 25.6% 33.8%
16 0 === MLPutMatrix(retseries”, B4:09) 2.646%| 6.605% 44 3% 19.1% 36.6%
17 2.850%| 6.685% 438.0% 12.7% 39.3%
18 |2. Execute MATLAB Financial Toolbox functions. 3.055%| 6.766% 51.6% 6.3% 42 1%
19 0 === MLEval3tring(7[ret, cov] = ewstats(retseries)”) 3.262%| 6.846% 55.0% 0.0% 45.0%
20 0 === MLEval3tring("[risk, ror, weights] = portopt(ret, cov, 20)™) 3.620%| 6.926% 41.3% 0.0% 58.7%
21 4.213%| 7.006% 27.5% 0.0% 72.5%
22 |3 Transfer output data to Excel. 4.955%] 7.086% 13.8% 0.0% 86.2%
23 0 === MLGetMatrix("risk”, "sheet5IF4") 5791%| 7.167% 0.0% 0.0% 100.0%
24 0 === MLGetMatrix("ror”, "sheetdlG4")
25 0 === MLGetMatrix("weights", "sheeta!H4")
26
27 |4. Plot efficient frontier data and label the figure.
28 |#MATLAB? === MLEvalString("portopt(ret, cov, 20); grid on; xlabel(Labels{1}); ylabel(Labels{2})")

5 Plot the efficient frontier for the same portfolio data by executing the Financial
Toolbox functions in cell A28.
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o

4. Efficient Frontier

(= ][ ][]

File Edit View Insert Tools Desktop Window Help
ﬂjlﬂié [:E t\-_'\-{fr?@@ﬁ;:'@: DIE EE
Mean-Variance-Efficient Frontier
0.072 . ; ; ; ; —
0.07 [ 1
0.068 [ 7
0.066 [ 7
o
O 0.064 | 4
o
0.062 -
0.06 | .
0.058 | 1
D_ DEI‘E 1 1 1 1 1
0 0.01 0.02 0.03 0.04 0.05
Risk

0.06

The light blue line shows the efficient frontier. Observe the change in slope above a
6.8% return because the Corporate Bond portfolio no longer contributes to the

efficient frontier.

To generate different efficient frontier data, close the figure and change the data in cells
B4 :D9. Then, execute all the Spreadsheet Link functions again. The worksheet updates
with new frontier data and MATLAB generates a new efficient frontier plot.
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See Also
MLEvalString | MLGetMatrix | MLPutMatrix | ewstats | portopt

More About

. “Model Data Using Regression and Curve Fitting” on page 2-2
. “Interpolate Thermodynamic Data” on page 2-10

. “Price Stock Options Using Binomial Model” on page 2-15

. “Map Time and Bond Cash Flows” on page 2-23

. “Executing Spreadsheet Link Functions” on page 1-42



Map Time and Bond Cash Flows

Map Time and Bond Cash Flows

This example shows how to use Financial Toolbox and Spreadsheet Link to calculate a set
of cash flow amounts and dates for a portfolio of five bonds.

Open the Ex1iSamp.x1s file and select the Sheet6 worksheet. For help finding the
Ex1iSamp.x1s file, see “Installation” on page 1-3.

This worksheet contains the maturity dates and coupon rates for five bonds.

A B C D E F G H | J K L M N
1 |Cash Flow and Time Mapping for a Portfolio of Bonds

2 Cash Flow Dates
3 |Settlement Date 26-Jul-99 Bond1

4 Bond2

5 Bond Data Bond3

6 Bond4

7 Maturity Coupon Rate Bond5

5 |Bond1 15-Nov-99 0.05875

9 |Bond2 16-May-00 0.06375

10 |Bond3 15-Nov-00 0.08500

11 |Bond4 15-May-01 0.08000

12 |Bond3 15-Mov-01 0.15750 Cash Flow Amounts
13

14 Bond1

15 Bond2

16 | Spreadsheet Link Functions Bond3

17 |1. Transfer data to MATLAB. Bond4

18 [#MATLAB" <== MLPutMatrix{"maturity”, Maturity’) Bond5

19 |#MATLAB’ <== MLPutMatrix("cpnrate”,"CpnRate")
20 |#MATLAB’ <== MLPutMatrix("sd",C3)

22 |2. Execute MATLAB Financial Toolbox Cash flow and Time mapping function.
23 #MATLAB’ === MLEvalString("md = x2mdate(maturity.0); sdm = x2mdate(sd.0)")
24 |#MATLAB' <== MLEvalString("[cfa, cfd] = cfamounts(cpnrate, sdm, md, 2)")

26 |3. Transform date numbers to cell array of character vectors.

27 |#MATLAEI'<== MLEwalString("i = find(isnan(cfd)); zcfd = cfd; zcfd(i) = 0; scfd=datestr{zcfd,2);")

28 |BMATLAB" «== MLEvalstring("ccfd = num2cell{scfd.2); ccfd(i) = {N/AT}: ccfd = reshape(ccfd, size(cfd)):")
29 [#MATLAB’ === MLEvalString("ccfa = cfa; ccfa(i) = 0; alldates = ccfd{end, :).")

30

31 |4. Transfer output data to Excel.

32 |#MATLAB' <== MLGetMatrix("ccfd", "sheetBli3")

33 |#MATLAB' <== MLGetMatrix("alldates", "sheet6li13")

34 |#MATLAB" === MLGetMatrix("ccfa”, "sheetfli14")

35

36 |5. Plot the cash flow diagram.

37 |[#MATLAB’ <== MLEvalString("cfplot(cfd, cfa); dtaxis(x',6,sdm,50);title(Cash Flow Diagram’);xlabel(Cash Flow Dates'):ylabel(Bonds’);")

Note This example requires Financial Toolbox, Statistics and Machine Learning Toolbox,
and Optimization Toolbox.
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1  Execute the Spreadsheet Link function that transfers the column vector Maturity to
the MATLAB workspace by double-clicking the cell A18 and pressing Enter.

2 Transfer the column vector Coupon Rate to the MATLAB workspace by executing

the function in cell A19.

3 Transfer the settlement date to the MATLAB workspace by executing the function in

cell A20.

4 Calculate cash flow amounts and dates by executing the Financial Toolbox functions

in cells A23 and A24.

5 Transform the dates into a cell array of character vectors by executing the functions

in cells A27 through A29.

6 Transfer the data to the Excel worksheet by executing the functions in cells A32

through A34.

A B c

Cash Flow and Time Mapping for a Portfolio of Bonds

Settlement Date 26-Jul-99
Bond Data

Maturity Coupon Rate

Bond1 15-Nov-99 0.05875
Bond2 15-May-00 0.06375
Bond3 15-Nav-00 0.08500
Bond4 15-May-01 0.08000
Bond5 15-Nov-01 0.15750

Spreadsheet Link Functions
1. Transfer data to MATLAB.

0 === MLPutMatrix("maturity", Maturity’)
0 === MLPutMatrix("cpnrate”,"CpnRate")

0 === MLPutMatrix("sd",C3)

2. Execute MATLAB Financial Toolbox Cash flow and Time mapping function.
0 === MLEvalString("md = x2mdate(maturity.0); sdm = x2mdate(sd.0)")
0 === MLEvalString("[cfa, cfd] = cfamounts(cpnrate, sdm, md, 2)")

3. Transform date numbers to cell array of character vectars.

Bond1
Bond2
Bond3
Bond4
Bond5

Bond1
Bond2
Bond3
Bond4
Bond5

K L M N

Cash Flow Dates

7/26/1999 11/15/1999 NIA N/A /A MNIA
7/26/1999 11/15/1999 5/15/2000 N/A N/A NIA
7/26/1999 11/15/1999 &/15/2000 11/15/2000  M/A NIA,
7/26/1999 11/15/1999 5/15/2000 11/15/2000 5/15/2001 MNIA
7/26/1999 11/15/1999 5/15/2000 11/15/2000 515/2001 11/15/2001
Cash Flow Amounts
7/26/1999 11/15/1999 5/15/2000 11/15/2000 5/15/2001 11/15/2001
-1.1495  102.9375 0 0 0 0
-1.2473 3.1875  103.1875 0 0 0
-1.6630 4.2500 42500  104.2500 0 0
-1.5652 4.0000 4.0000 4.0000  104.0000 0
-3.0815 7.8750 7.8750 7.8750 7.6750  107.8750

0 «== MLEvalString("i = find(isnan(cfd)); zcfd = cfd; zcfd(i) = 0: scfd=datestr(zcfd.2);")
0 === MLEvalstring("ccfd = num2cell(scfd.2); ccfd(i) = {N/A}: ccfd = reshape(cefd, size(cfd)).")

0 === MLEvalString("ccfa = cfa; ccfa(i) = 0; alldates = ccfd{end, :);")

4. Transfer output data to Excel.

0 <== MLGetMatrix("ccfd", "sheet6li3")
0 «== MLGetMatrix("alldates", "sheetbli13")
0 «== MLGetMatrix("ccfa", "sheetfli14")

5. Plot the cash flow diagram.

0 === MLEvalString("cfplot(cfd, cfa), dtaxis(x’,6,sdm 50) title(Cash Flow Diagram’).xlabel(Cash Flow Dates’).ylabel(Bonds’).")




Map Time and Bond Cash Flows

7 Display a plot of cash flows for each bond by executing the function in cell A37.

o

4/ Figure1 =N ol ==

File

Udde MW RSKSOHDEMN- 2 0E o

Edit VMiew Insert Tools Desktop Window Help N

Cash Flow Diagram

L]
|
A S S S |

07/26 11/15 05/15 11/15 05/15 11/15
Cash Flow Dates

To generate cash flows for a different set of five bonds, close the figure and change the
bond data in cells B8:C12. Then, execute all the Spreadsheet Link functions again. The
worksheet updates with new cash flow dates and amounts and MATLAB generates a new
figure of the cash flows.
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See Also

MLEvalString | MLGetMatrix | MLPutMatrix | cfamounts | cfplot | x2mdate
More About

. “Model Data Using Regression and Curve Fitting” on page 2-2

. “Interpolate Thermodynamic Data” on page 2-10

. “Price Stock Options Using Binomial Model” on page 2-15

. “Plot Efficient Frontier of Financial Portfolios” on page 2-19

. “Executing Spreadsheet Link Functions” on page 1-42



Error Messages and
Troubleshooting

* “Worksheet Cell Errors” on page 3-2

* “Microsoft Excel Errors” on page 3-6

* “Data Errors” on page 3-10

* “License Errors” on page 3-12

* “Startup Errors” on page 3-13
“Audible Error Signals” on page 3-15



3 Error Messages and Troubleshooting

Worksheet Cell Errors

You might see these error messages displayed in a worksheet cell.

The first column contains worksheet cell error messages. The error messages begin with
the number sign (#). Most end with an exclamation point (!) or with a question mark (?).

3-2



Worksheet Cell Errors

Worksheet Cell Error Messages

Error Message

Meaning

Solution

#COLS>#MAXCOLS! Your MATLAB variable exceeds the |This is a limitation in the Excel
Microsoft Excel limit of product. Try the computation with a
#MAXCOLS! columns. variable containing fewer columns.

#COMMAND ! This error message represents any |Troubleshoot the MATLAB error.
error that appears at the MATLAB
command line. You can show the
full error message from the
MATLAB command line by using
the MLShowMatlabErrors
function. Or, you can set the
corresponding preference in the
Preferences dialog box available
from the MATLAB group on the
Excel Home tab.

#DIMENSION! You used MLAppendMatrix and |Verify the matrix dimensions and
the dimensions of the appended the appended data dimensions, and
data do not match the dimensions |correct the argument. For more
of the matrix you want to append. |information, see the

MLAppendMatrix reference page.

#INVALIDNAME! You entered an invalid variable Ensure that you use valid MATLAB

name. variable names. MATLAB variable
names must start with a letter,
followed by letters, digits, or
underscores. For details, see
“Variable Names” (MATLAB).

#INVALIDTYPE! You specified an illegal MATLAB  |Make sure to use the supported
data type with MLGetVar or MATLAB data types.
MLGetMatrix.

#MATLAB? You used a Spreadsheet Link Start the Spreadsheet Link and

function and no MATLAB software
session is running.

MATLAB software. See “Start and
Stop Spreadsheet Link and
MATLAB” on page 1-15.
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Error Message

Meaning

Solution

#NAME? The function name is Be sure the excllink.x1la add-in
unrecognized. The excllink.x1la |is loaded. See “Add-In Setup” on
add-in is not loaded, or the page 1-6. Check the spelling of the
function name might be function name. Correct typing
misspelled. errors.

#NONEXIST! You referenced a nonexistent Verify the spelling of the MATLAB
matrix in an MLGetMatrix or matrix. Use the MATLAB whos
MLDeleteMatrix function. The |command to display existing
matrix name might be misspelled. |matrices. Correct typing errors.
Also, you receive the #NONEXIST!
error when you attempt to use
matlabfcn to obtain an output.

#ROWS>#MAXROWS ! Your MATLAB variable exceeds the |This is a limitation in the Excel
Excel limit of #MAXROWS ! rows. product. Try the computation with a

variable containing fewer rows.

#SYNTAX? You entered a Spreadsheet Link | Verify and correct the function
function with incorrect syntax. For |syntax.
example, you did not specify
double quotation marks ("), or
you specified single quotation
marks (') instead of double
quotation marks.

#VALUE! An argument is missing from a Supply the correct number of
function, or a function argument is |function arguments, of the correct
the wrong type. type.

#VALUE! A macro subroutine uses Since the function works correctly,

MLGetMat rix followed by
MatlabRequest, which is correct
standard usage. A macro function
calls that subroutine, and you
execute that function from a
worksheet cell. The function works
correctly, but this message
appears in the cell.

ignore the message. Or, in this
special case, remove
MatlabRequest from the
subroutine.
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Error Message Meaning Solution
#INVALIDRANGE! The named range is defined Select a range of data on only one
incorrectly, or the named range worksheet and create an
spans multiple worksheets. appropriate name for the range of
data. For instructions about
defining names, see Excel Help.

Note When you open an Excel worksheet that contains Spreadsheet Link functions, the
Excel software tries to execute the functions from the bottom up and right to left. Excel
might generate cell error messages such as #COMMAND ! or #NONEXIST!. This is expected
behavior, so ignore the messages and do the following:

1 Close the MATLAB figure windows.

2 Execute the cell functions again one at a time in the correct order by pressing F2,
and then Enter.
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Microsoft Excel Errors

3-6

The Excel software can display these error messages.

Error Message

Cause of Error

Solution

Error in formula

You entered a formula
incorrectly. Common errors
include a space between the
function name and the left
parenthesis; or missing,
extra, or mismatched
parentheses.

Note If you use the
Spreadsheet Link software
with a non-English (United
States) Windows desktop
environment, certain
syntactical elements might
not work. For details, see
“Localization Information”
on page 1-41.

Review the entry and
correct typing errors.

Can't find project or
library

or

Compile error: Sub or
Function not defined

You executed a macro and
the location of
excllink.xla is incorrect
or not specified.

Click OK. The References
window opens. Remove the
check mark from MISSING:
excllink.x1la. Find
excllink.x1la in its
correct location, select its
check box in the References
window, and click OK. Or,
select Tools > References
to open the References
window. Select the box
named
SpreadsheetlLink2007 2
010. Click OK.




Microsoft Excel Errors

Error Message

Cause of Error

Solution

Run-time error
'1004': Cells method
of Application class
failed

You used MLGetMatrix and
the matrix is larger than the
space available in the
worksheet. This error
destabilizes the Spreadsheet
Link software session and
changes worksheet
calculation mode to manual.

Click OK. Reset worksheet
calculation mode to
automatic, and save your
worksheet as needed.
Restart the Excel,
Spreadsheet Link, and
MATLAB software sessions.

MATLAB failed to
check out a license
of Spreadsheet Link
or does not have a
valid installation of
Spreadsheet Link

You entered an invalid
license pass code or did not
install Spreadsheet Link

properly.

Ensure that you entered the
license pass code properly.
Reinstall the Spreadsheet
Link add-on. (See
“Installation” on page 1-3.)
If you followed the
installation guidelines, used
a proper pass code, and you
are still unable to start the
Spreadsheet Link software,
contact your MathWorks®
representative.

Datasource: Excel;
prompt for user name
and password

This message appears when
an attempt to connect to the
Excel software from the
Database Toolbox™
software fails.

Ensure that the Excel
worksheet referenced by the
data source exists, then
retry the connection.

Could not load some
objects because they
are not available on
this machine

This message appears when
Excel 2013 is not configured

properly.

From the Windows Control
Panel, remove Microsoft
Office 2010 in the programs
list.
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Error Message

Cause of Error

Solution

Microsoft Visual Basic

Run-time error ‘429"

ActiveX component can't reate object

End

Help

This error appears when you
start the automation server
from the Excel interface,
and multiple versions of the
MATLAB software are
installed on your desktop.

To correct this error, ensure
that you have administrator
privileges on your machine
and then perform the
following:

1 Shut down all MATLAB
and Excel instances.

2 Open a command
prompt, and using cd,
change to the bin
\win64 subfolder of the
MATLAB installation
folder.

3 Type the command:

.\matlab /regserver

4 When the MATLAB
session starts, close it.
Using /regserver
fixes the registry
entries.

5 Start an Excel session.
The Spreadsheet Link
add-in now loads
properly.

6 Verify that the
Spreadsheet Link
software is working by
entering the following
command from the
Command Window:

a = 3.14159

7  Enter the following
formula in cell Al of the
open Excel worksheet:




Microsoft Excel Errors

=mlgetmatrix("a","al"

8 The value 3.14159
appears in cell Al.

3-9



3 Error Messages and Troubleshooting

Data Errors

In this section...

“Matrix Data Errors” on page 3-10

“Errors When Opening Saved Worksheets” on page 3-10

Matrix Data Errors

Data in the MATLAB or Microsoft Excel workspaces may produce the following errors.

Data Errors

Data Error

Cause

Solution

MATLAB matrix cells
contain zeros (0).

cells are empty.

Corresponding Excel worksheet

Excel worksheet cells must contain
only numeric or string data.

MATLAB matrix is a 1-by-1

zZero matrix.

MLPutMatrix or
MLAppendMatrix.

You used quotation marks around
the data-location argument in

Correct the syntax to remove
quotation marks.

MATLAB matrix is empty

(D.

variable in MLPutVar.

You referenced a nonexistent VBA

Correct the macro; you may have
typed the variable name
incorrectly.

VBA matrix is empty.

You referenced a nonexistent
MATLAB variable in MLGetVar.

Correct the macro; you may have
typed the variable name
incorrectly.

Errors When Opening Saved Worksheets

This section describes errors that you may encounter when opening saved worksheets.

3-10

When you open an Excel worksheet that contains Spreadsheet Link functions, the
Excel software tries to execute the functions from the bottom up and right to left.
Excel may generate cell error messages such as #COMMAND ! or #NONEXIST!. This is

expected behavior. Do the following:

1 Ignore the messages.




Data Errors

2
3

Close MATLAB figure windows.

Execute the cell functions again one at a time in the correct order by pressing F2,
and then Enter.

If you save an Excel worksheet containing Spreadsheet Link functions, and then
reopen it in an environment where the excllink.x1la add-in is in a different location,
you may see the message: This document contains links: Re-establish
links?

To address this issue, do the following:

A W N =

Click No.
Select Edit > Links.
In the Links dialog box, click Change Source.

In the Change Links dialog box, select matlabroot\toolbox\exlink
\excllink.xla.

Click OK.

The Excel software executes each function as it changes its link. You may see
MATLAB figure windows and hear error beeps as the links change and functions
execute; ignore them.

In the Links dialog box, click OK.

The worksheet now connects to the Spreadsheet Link add-in.

Or, instead of using the Links menu, you can manually edit the link location in each
affected worksheet cell to show the correct location of excllink. x1la.
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License Errors

If you are running an automation server of MATLAB that does not have a Spreadsheet
Link license associated with it, you will receive an license error message. To correct this
issue, from the MATLAB installation that includes Spreadsheet Link, run the command:

matlab /regserver
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Startup Errors

In this section...
“MATLAB Automatic Start Error” on page 3-13
“MATLAB Version Errors” on page 3-13

MATLAB Automatic Start Error

If you have enabled MLAutoStart and MLUseFullDesktop, right-clicking a spreadsheet
file in the MATLAB Current Folder browser and choosing Open Outside MATLAB causes
a MATLAB System Error to appear. To open the file successfully, click End Now in the
error window.

To avoid this issue, disable MLUseFullDesktop.

MATLAB Version Errors

If the MATLAB version is set incorrectly, MATLAB does not start and displays this error:
Unable to start MATLAB. Please register MATLAB Software as a COM
Server. Set the MATLAB version using MLProgramId.

Ensure that the correct MATLAB version appears in the Preferences dialog box before
starting MATLAB. For details, see “Setting Spreadsheet Link Preferences” on page 1-12.

If MATLAB is installed on your computer and setting the MATLAB version does not work,
use the last registered version to start MATLAB. To specify the last registered version of
MATLAB:

Shut down all MATLAB and Excel sessions.

Open a command prompt window, and using cd, change to the bin\win64 subfolder
of the MATLAB installation folder.

3 Enter the command:

.\matlab /regserver

See Also
MLAutoStart | MLProgramId

3-13



3 Error Messages and Troubleshooting

More About

. “Installation” on page 1-3
. “Add-In Setup” on page 1-6
. “Setting Spreadsheet Link Preferences” on page 1-12
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Audible Error Signals

Audible Error Signals

You may hear audible errors while passing data to the MATLAB workspace using
MLPutMatrix or MLAppendMatrix. These errors usually indicate that you have
insufficient computer memory to carry out the operation. Close other applications or clear
unnecessary variables from the MATLAB workspace and try again. If the error signal

reoccurs, you probably have insufficient physical memory in your computer for this
operation.
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matlabfcn

Evaluate MATLAB command given Microsoft Excel data

Syntax

= matlabfcn(command, inputs)

Description

= matlabfcn(command, inputs) specifies the MATLAB command for evaluation in the
MATLAB workspace, given the input data inputs. Depending upon the MATLAB output,
matlabfcn returns a single value or string into the calling worksheet cell. If the result
contains more than one value in MATLAB, only the first value in the array returns in the
calling worksheet cell. Use this syntax when working in a worksheet cell.

Examples

Find Maximum Likelihood Estimate

Using std, find the maximum likelihood estimate of the standard deviation of data in
worksheet cells A1 through A10. Assume that the data comes from a normal population.
Specify a weight of one in cell C1. Return the result by entering this text into cell A12.

=matlabfcn("std",Al:A10,C1)



matlabfcn

A E C
11.3442
14.5847

4,3529
12.1554
10.7969

6.7308

8.916
10.8566

18.946
16.923 El.

—1
L=

[V R B T O B = N o B

—
[

11

12 |:matlabfcn{”Etd“,ﬂL:ALE,Cl}l

Cell A12 displays the maximum likelihood estimate of the standard deviation.
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A E C
11.3442 1
14.5847

4,3529
12.1554
10.7969

6.7308

8.916
10.8566

18.946

16.9236

W 0 =] &N s L R

—
[

11
12| 4.197647
13

Input Arguments
command — MATLAB command to evaluate

string

MATLAB command to evaluate, specified as a string. Enclose the string in double quotes.
Or, enter the string in a cell without quotes and enter the corresponding cell reference
without quotes as the input argument.

Example: "sum"

Example: A1

inputs — MATLAB command input arguments
Excel cell reference

MATLAB command input arguments, specified as an Excel cell reference or a reference to
a range of cells. To specify multiple input arguments for a function, separate the cell
references with commas.

Example: B1:B10
Example: A1:C1,A3
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Tip
+ Ifmatlabfcn fails, a standard Spreadsheet Link error displays by default; for
example, #COMMAND. To return MATLAB errors, use MLShowMatlabErrors.

See Also
MLShowMatlabErrors | matlabsub | std

Topics

“Create Diagonal Matrix Using Worksheet Cells” on page 1-25
“Executing Spreadsheet Link Functions” on page 1-42
“Worksheet Cell Errors” on page 3-2

“Microsoft Excel Errors” on page 3-6

Introduced before R2006a
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matlabinit

Initialize Spreadsheet Link and start MATLAB

Syntax

matlabinit

Description

matlabinit Initializes the Spreadsheet Link software and starts MATLAB process. If the
Spreadsheet Link software has been initialized and the MATLAB software is running,
subsequent invocations do nothing. Use matlabinit to start Spreadsheet Link and
MATLAB sessions manually when you have set MLAutoStart to no. If you set
MLAutoStart to yes, matlabinit executes automatically.

Tips

* Torun matlabinit from the Microsoft Excel toolbar, click Tools > Macro. In the
Macro Name/Reference box, enter matlabinit and click Run. Alternatively, you
can include this function in a macro subroutine. You cannot run matlabinit as a
worksheet cell formula or in a macro function.

See Also
MLAutoStart | MLOpen

Topics

“Create Diagonal Matrix Using Microsoft Excel Ribbon” on page 1-18

“Create Diagonal Matrix Using Microsoft Excel Context Menu” on page 1-21

“Create Diagonal Matrix Using Worksheet Cells” on page 1-25

“Create Diagonal Matrix Using VBA Macro” on page 1-28

“Find and Execute MATLAB Function Using MATLAB Function Wizard” on page 1-30
“Executing Spreadsheet Link Functions” on page 1-42



matlabinit

Introduced before R2006a
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matlabsub

Evaluate MATLAB command given Microsoft Excel data and designate output location

Syntax

= matlabsub(command, result, inputs)

Description

= matlabsub(command, result, inputs) specifies the MATLAB command for
evaluation in the MATLAB workspace, given the input data inputs. The function returns
the MATLAB output into the worksheet cell specified by result. Use this syntax when
working in a worksheet cell.

Examples

Return Fourth-Order Magic Square in Worksheet Cell
Enter the number four in cell Al.

Enter this text into cell A2. Specify the function magic as the command. Return the
fourth-order magic square into the range of cells starting in cell A4. Reference cell Al as
the input argument for the magic function.

=matlabsub("magic", "A4",6Al)

A B C
1 4|

2 |:matlabﬁub{"magic",".ﬂ.d",;'_}|

The fourth-order magic square displays in the range of cells from A4 through D7.



matlabsub

A B C D

1 4

2 0

3 :I

4 16 2 3 13
5 5 11 10 8
6 9 7 6 12
7 a 14 15 1

Return Fourth-Order Magic Square in Target Worksheet Cell
Enter the number four in cell Al. Enter a target cell reference to cell A6 in cell A2.

Enter this text into cell A4. Specify the function magic as the command. Return the
fourth-order magic square into the range of cells starting in cell A6 by entering the cell
reference A2. Reference cell Al as the input argument for the magic function.

=matlabsub("magic",A2,Al)

(ISR I
=
(=)}

4 |:matlabﬁLib{"magic",gj,iiﬂ

The fourth-order magic square displays in the range of cells from A6 through D9.
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A E C D

1 4

2 AB

4 0

5 :I

5] 16 2 3 13
7 5 11 10 8
8 9 7 6 12
9 4 14 15 1

Input Arguments

command — MATLAB command to evaluate
string

MATLAB command to evaluate, specified as a string. Enclose the string in double quotes.
Or, enter the string in a cell without quotes and enter the corresponding cell reference
without quotes as the input argument.

Example: "sum"

Example: Al

result — MATLAB result
Excel cell reference

MATLAB result, specified as an Excel cell reference or range name that designates the
location where to display the result of the MATLAB command. To return the result in a
specific cell, specify the cell reference enclosed in quotes. To denote a worksheet cell
address or range name that contains a cell reference to another cell, specify the cell
reference without quotes.

Example: "A3"
Example: D6

inputs — MATLAB command input arguments
Excel cell reference
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MATLAB command input arguments, specified as an Excel cell reference or a reference to
a range of cells. To specify multiple input arguments for a function, separate the cell
references with commas.

Example: B1:B10
Example: A1:C1,A3

Tips
* Toreturn an array of data to the Microsoft Excel Visual Basic for Applications (VBA)
workspace, see MLEvalString and MLGetVar.

e result must not include the cell that contains matlabsub. Do not overwrite the
function itself.

» Ensure that there is enough room in the worksheet for writing matrix contents. If
there is insufficient room, the function generates a fatal error.

+ Ifmatlabsub fails, a standard Spreadsheet Link error displays by default; for
example, #COMMAND. To return MATLAB errors, use MLShowMatlabErrors.

See Also
MLShowMatlabErrors | magic | matlabfcn

Topics

“Create Diagonal Matrix Using Worksheet Cells” on page 1-25
“Executing Spreadsheet Link Functions” on page 1-42
“Worksheet Cell Errors” on page 3-2

“Microsoft Excel Errors” on page 3-6

Introduced before R2006a
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MLAppendMatrix

Create or append MATLAB matrix with data from Microsoft Excel worksheet

Syntax

= MLAppendMatrix(var_name,mdat)
MLAppendMatrix var_name,mdat
out = MLAppendMatrix(var _name,mdat)

Description

= MLAppendMatrix(var_name,mdat) appends data in mdat to MATLAB matrix
var _name or creates var_ name if it does not exist. Use this syntax when working directly
in a worksheet.

MLAppendMatrix var_name,mdat appends data in mdat to MATLAB matrix var_name
or creates var_name if it does not exist. Use this syntax in a VBA macro.

out = MLAppendMatrix(var name,mdat) lets you catch errors when executing
MLAppendMatrix in a VBA macro. If MLAppendMatrix fails, then out is a string
containing error code. Otherwise, out is 0.

Input Arguments
var_name
Name of MATLAB matrix to which to append data.

var_name in quotes directly specifies the matrix name. var name without quotes
specifies a worksheet cell address (or range name) that contains the matrix name. Do not
use the MATLAB variable ans as var_name.

mdat

Location of data to append to var_name.
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mdat must be a worksheet cell address or range name. Do not enclose it in quotes.
mdat must contain either numeric data or string data. Data types cannot be combined

within the range specified in mdat. Empty mdat cells become MATLAB matrix elements
containing zero if the data is numeric, and empty character vectors if the data is a string.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Append Data from a Worksheet Cell Range to a MATLAB Matrix

In this example, B is a 2-by-2 MATLAB matrix. Append the data in worksheet cell range
Al:A2 to B:

MLAppendMatrix("B", Al:A2)

Al
A2

B is now a 2-by-3 matrix with the data from A1:A2 in the third column.

Append Data from a Named Worksheet Cell Range to a MATLAB Matrix

B is a 2-by-2 MATLAB matrix. Cell C1 contains the label B, and new_data is the name of
the cell range Al:B2. Append the data in cell range Al1:B2 to B:

MLAppendMatrix(C1l, new data)
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Al

B1

A2

B2

B is now a 4-by-2 matrix with the data from A1:B2 in the last two rows.

Ti

ps

MLAppendMatrix checks the dimensions of var name and mdat to determine how to
append mdat to var_name. If the dimensions allow appending mdat as either new
rows or new columns, it appends mdat to var _name as new rows. If the dimensions do
not match, the function returns an error.

If mdat is not initially an Excel Range data type and you call the function from a
worksheet, MLAppendMat rix performs the necessary type coercion.

If mdat is not an Excel Range data type and you call the function from within a
Microsoft Visual Basic macro, the call fails. The error message ByRef Argument
Type Mismatch appears.

See Also
MLPutMatrix

Introduced before R2006a
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MLAutoStart

Automatically start MATLAB

Syntax

= MLAutoStart(flag)
MLAutoStart flag
out = MLAutoStart(flag)

Description

= MLAutoStart(flag) sets automatic startup of the Spreadsheet Link and MATLAB
software. A change of state takes effect the next time an Excel session starts. Use this
syntax when working directly in a worksheet.

MLAutoStart flag sets automatic startup of the Spreadsheet Link and MATLAB
software. A change of state takes effect the next time an Excel session starts. Use this
syntax in a VBA macro.

out = MLAutoStart(flag) lets you catch errors when executing MLAutoStart in a
VBA macro. If MLAutoStart fails, then out is a string containing error code. Otherwise,
out is 0.

Input Arguments

flag

Either "yes" or "no".

Specify "yes" to automatically start the Spreadsheet Link and MATLAB software every
time a Microsoft Excel session starts. Specify "no" to cancel automatic startup of the

Spreadsheet Link and MATLAB software.

Default: "yes"
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Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Cancel Automatic Startup of Spreadsheet Link and MATLAB

Enter this command in a worksheet:

MLAutoStart("no")

Spreadsheet Link and MATLAB do not start on subsequent Excel session invocations.

Tips

» If Spreadsheet Link and MATLAB are running, then MLAutoStart("no") does not
stop them.

See Also
MLClose | MLOpen | matlabinit

Topics
“Start Spreadsheet Link and MATLAB Automatically” on page 1-15

Introduced before R2006a
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MLProgramld

Specify MATLAB version

Syntax

= MLProgramId(version)
MLProgramId version

Description

= MLProgramId(version) specifies the MATLAB version to open when Spreadsheet
Link starts in Microsoft Excel. Enter this syntax when working in a worksheet cell.

MLProgramId version specifies the MATLAB version. Enter this syntax when working
in a VBA macro.

Examples

Specify MATLAB Version in Worksheet Cells

To open MATLAB (R2016a) in Microsoft Excel, enter this text in any worksheet cell:
=MLProgramId("9.0")

The worksheet cell displays © when MLProgramId runs.

To check that the preference is set, open the Preferences dialog box. The MATLAB
program id box contains 9. 0. For details about the Preferences dialog box, see “Setting
Spreadsheet Link Preferences” on page 1-12.

Start MATLAB.

For troubleshooting, see “Startup Errors” on page 3-13.
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Specify MATLAB Version in VBA Macro

To open MATLAB (R2016a) in Microsoft Excel, enter this text at the beginning of the VBA
macro:

MLProgramId "9.0"

Run the macro by clicking Run Macro (F5). For details about running macros, see Excel
Help.

To check that the preference is set, open the Preferences dialog box. The MATLAB
program id box contains 9. 0. For details about the Preferences dialog box, see “Setting
Spreadsheet Link Preferences” on page 1-12.

Start MATLAB.

For troubleshooting, see “Startup Errors” on page 3-13.

Input Arguments

version — MATLAB version
string

MATLAB version, specified as a string to indicate which MATLAB version to open when
multiple versions are installed on the computer.

The Windows registry defines the MATLAB version number under . . .\Mathworks
\MATLAB. For example, MATLAB R2016a corresponds to version 9.0 in the registry.
Example: "9.0"

See Also
MLAutoStart | MLOpen

Topics
“Setting Spreadsheet Link Preferences” on page 1-12
“Startup Errors” on page 3-13
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Introduced in R2016b
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MLClose

Stop MATLAB

Syntax

= MLClose()
MLClose
out = MLClose()

Description

= MLClose() ends the MATLAB process, deletes all variables from the MATLAB
workspace, and tells the Microsoft Excel software that the MATLAB software is no longer
running. Use this syntax when working directly in a worksheet.

MLClose ends the MATLAB process, deletes all variables from the MATLAB workspace,
and tells the Microsoft Excel software that the MATLAB software is no longer running.
Use this syntax in a VBA macro.

out = MLClose() lets you catch errors when executing MLClose in a VBA macro. If
MLClose fails, then out is a string containing error code. Otherwise, out is 0.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

End the MATLAB Session
End the MATLAB session from a worksheet:



MLClose

MLClose()

Tips

* Ifyou use MLClose when no MATLAB process is running, nothing happens.

See Also
MLAutoStart | MLOpen

Topics
“Stop Spreadsheet Link and MATLAB” on page 1-17

Introduced before R2006a
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MLDeleteMatrix

Delete MATLAB matrix

Syntax

= MLDeleteMatrix(var_name)
MLDeleteMatrix var_name
out = MLDeleteMatrix(var_name)

Description

= MLDeleteMatrix(var_name) deletes the named matrix from the MATLAB
workspace. Use this syntax when working directly in a worksheet.

MLDeleteMatrix var_name deletes the named matrix from the MATLAB workspace.
Use this syntax in a VBA macro.

out = MLDeleteMatrix(var name) lets you catch errors when executing
MLDeleteMatrix in a VBA macro. If MLDeleteMatrix fails, then out is a string
containing error code. Otherwise, out is 0.

Input Arguments
var_name
Name of MATLAB matrix to delete.

var_name in quotes directly specifies the matrix name. var name without quotes
specifies a worksheet cell address (or range name) that contains the matrix name.



MLDeleteMatrix

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Delete a Matrix from the MATLAB Workspace

Delete matrix A from the MATLAB workspace:

MLDeleteMatrix("A")

See Also
MLAppendMatrix | MLGetMatrix | MLPutMatrix

Introduced before R2006a
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MLEvalString

Evaluate MATLAB command in MATLAB

Syntax

= MLEvalString(command)

MLEvalString command
err = MLEvalString(command)

Description

= MLEvalString(command) specifies the MATLAB command for evaluation in the
MATLAB workspace. Use this syntax when working in a worksheet cell.

MLEvalString command works in a VBA macro.

err = MLEvalString(command) returns the execution status when executing
MLEvalString in a VBA macro.

Examples

Create Diagonal Matrix in Worksheet Cells

Enter the variable a into cell Al. Enter the numbers 1 through 5 into the range of cells
from B1 through F1.

Assign the range of cells to variable a in MATLAB using MLPutMatrix. Enter this text in
cell A3.

=MLPutMatrix (Al,B1:F1)
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A E C D E F
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Use diag to create a matrix b, containing a diagonal using the five numbers in variable a.
Enter this text in cell A5.

=MLEvalString("b = diag(a);")

A E C D E F

0

5 |:MLEvaI5tring|{“b = diag{a}”}|

Retrieve matrix b from MATLAB into Excel, cell A9. Enter this text in cell A7.

O N N B

=MLGetMatrix("b","A9")

The matrix with the diagonal appears in cells A9 through E13.
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Create Diagonal Matrix in VBA Macro

Enter the variable a into cell Al. Enter the numbers 1 through 5 into the range of cells
from B1 through F1.

Click the Developer tab in Microsoft Excel, and then click Visual Basic. The Visual Basic
Editor window opens.

Insert a new module and enter this VBA code into the Code section of the window. This
sample code assumes a macro named Diagonal. For details on working with modules,
see Excel Help.

Sub Diagonal()
MLPutMatrix "a", Range("Bl:F1")
MLEvalString "b = diag(a);"
MLGetMatrix "b", "A3"
MatlabRequest

End Sub



MLEvalString

Run the macro by clicking Run Sub/UserForm (F5). The diagonal matrix appears in
cells A3 through E7. For details on running macros, see Excel Help.

A E C D E F

1 |a 1 2 3 4 5
2

3 1 0 0 0 0

4 0 2 0 0 0

] 0 0 3 0 0

& 0 0 0 4 0

7 0 0 0 0 5

Return Error for Invalid Command

Enter the variable a into cell Al. Enter the numbers 1 through 5 into the range of cells
from B1 through F1.

Click the Developer tab in Microsoft Excel, and then click Visual Basic. The Visual Basic
Editor window opens.

Insert a new module and enter this invalid VBA code into the Code section of the window.
This sample code assumes a macro named Diagonal. For details on working with
modules, see Excel Help.

Sub Diagonal()
Dim err As Variant

MLPutMatrix "a", Range("Bl:F1")
err = MLEvalString("b = diag(2a);") 'Invalid code

If err <> 0 Then
MsgBox err
End If

MLGetMatrix "b", "A3"
MatlabRequest

End Sub
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Run the macro by clicking Run Sub/UserForm (F5). For details on running macros, see
Excel Help.

This Spreadsheet Link error displays: #COMMAND !. To display MATLAB errors, see
MLShowMatlabErrors.

Input Arguments

command — MATLAB command to evaluate
string

MATLAB command to evaluate, specified as a string. Enclose the string in double quotes.
Or, enter the string in a cell without quotes and enter the corresponding cell reference
without quotes as the input argument.

Example: "sum"

Example: Al

Output Arguments

err — Execution status
string | number

Execution status, returned as a string or number. If MLEvalString fails, then errisa
string containing an error code or error message. Otherwise, the command executes
successfully and err is 0.

By default when MLEvalString fails, err contains a standard Spreadsheet Link error,
such as #COMMAND. To return MATLAB errors, execute MLShowMatlabErrors.

Tip

* The specified action alters only the MATLAB workspace and has no effect on the
Microsoft Excel workspace.
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See Also
MLGetMatrix | MLPutMatrix | MLShowMatlabErrors | diag

Topics

“Create Diagonal Matrix Using Worksheet Cells” on page 1-25
“Create Diagonal Matrix Using VBA Macro” on page 1-28
“Model Data Using Regression and Curve Fitting” on page 2-2
“Interpolate Thermodynamic Data” on page 2-10

“Price Stock Options Using Binomial Model” on page 2-15
“Executing Spreadsheet Link Functions” on page 1-42
“Worksheet Cell Errors” on page 3-2

“Microsoft Excel Errors” on page 3-6

Introduced before R2006a
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MLGetFigure

Import current MATLAB figure into Microsoft Excel worksheet

Syntax

= MLGetFigure(width,height)
MLGetFigure width, height
out = MLGetFigure(width,height)

Description

= MLGetFigure(width,height) import the current MATLAB figure into an Excel
worksheet, where the top-left corner of the figure is the current worksheet cell. Use this
syntax when working directly in a worksheet.

MLGetFigure width, height import the current MATLAB figure into an Excel
worksheet, where the top-left corner of the figure is the current worksheet cell. Use this
syntax in a VBA macro.

out = MLGetFigure(width,height) lets you catch errors when executing
MLGetFigure in a VBA macro. If MLGetFigure fails, then out is a string containing
error code. Otherwise, out is 0.

Input Arguments

width

Width (in normalized units) of the MATLAB figure when imported into an Excel
worksheet.

height

Height (in normalized units) of the MATLAB figure when imported into an Excel
worksheet.



MLGetFigure

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Import a MATLAB Figure into an Excel Worksheet

Import the current MATLAB figure into an Excel worksheet. Specify the width and the
height of the figure to be half those of the original figure:

MLGetFigure(.5,.5)

Note that if you use Microsoft Excel 2007 or 2010, the width and the height of the
imported figure will be a quarter of those of the original figure.

Tips

» Ifyou use Microsoft Excel 2007 or 2010, MLGetFigure scales the imported figure by
the product of width and height along both dimensions.

» If worksheet calculation mode is automatic, MLGetFigure executes when you enter
the formula in a cell. If worksheet calculation mode is manual, enter the
MLGetFigure function in a cell, then press F9 to execute it. Remember that pressing
F9 in this situation can also execute other worksheet functions again and generate
unpredictable results.

» Ifyou use MLGetFigure in a macro subroutine, enter MatlabRequest on the line
after the MLGetFigure. MatlabRequest initializes internal Spreadsheet Link
variables and enables MLGetFigure to function in a subroutine. Do not include
MatlabRequest in a macro function unless the function is called from a subroutine.

See Also
MLGetMatrix | MLGetVar
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Introduced in R2006b
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MLGetMatrix

Write contents of MATLAB matrix to Microsoft Excel worksheet

Syntax

= MLGetMatrix(var_name,edat)
MLGetMatrix var _name, edat
out = MLGetMatrix(var _name,edat)

Description

= MLGetMatrix(var_name,edat) writes the contents of MATLAB matrix var name in
the Excel worksheet, beginning in the upper-left cell specified by edat. Use this syntax
when working directly in a worksheet.

MLGetMatrix var_name, edat writes the contents of MATLAB matrix var name in
the Excel worksheet, beginning in the upper-left cell specified by edat. Use this syntax in
a VBA macro.

out = MLGetMatrix(var name,edat) lets you catch errors when executing

MLGetMatrix in a VBA macro. If MLGetMatrix fails, then out is a string containing
error code. Otherwise, out is 0.

Input Arguments

var_name
Name of MATLAB matrix to access.
var_name in quotes directly specifies the matrix name. var name without quotes

specifies a worksheet cell address (or range name) that contains the matrix name. Do not
use the MATLAB variable ans as var_name.
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edat
Worksheet location where the function writes the contents of var name.

edat in quotes directly specifies the location. edat without quotes specifies a worksheet
cell address (or range name) that contains a reference to the location. In both cases,
edat must be a cell address or a range name.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Specify the Matrix Name and Location Directly

Write the contents of the MATLAB matrix bonds starting in cell C10 of Sheet?2. If bonds
is a 4-by-3 matrix, fill cells C10. .E13 with data:

MLGetMatrix("bonds", "Sheet2!C10")

Specify the Matrix Name and Location Indirectly

Access the MATLAB matrix named by the string in worksheet cell B12. Write the contents
of the matrix to the worksheet starting at the location named by the string in worksheet
cell B13:

MLGetMatrix(B12, B13)

Use MLGetMatrix in a VBA Macro

Write the contents of MATLAB matrix A to the worksheet, starting at the cell named by
RangeA:



MLGetMatrix

Sub Get RangeA()
MLGetMatrix "A", "RangeA"
MatlabRequest

End Sub

Use the Address Property of the Range Object to Specify Location

In a macro, use the Address property of the range object returned by the VBA Cells
function to specify where to write the data:

Sub Get Variable()

MLGetMatrix "X", Cells(3, 2).Address
MatlabRequest

End Sub

Catch Errors in a VBA Macro

Use this function to get the variable A from MATLAB and to test if the command
succeeded:

Sub myfun()
Dim out As Variant

out = MLGetMatrix("A", "Al")
If out <> 0 Then
MsgBox out
End If
MatlabRequest
End Sub

If MLGetMatrix fails, myfun displays a message box with the error code.

Tips
» If data exists in the specified worksheet cells, it is overwritten.

» If the dimensions of the MATLAB matrix are larger than that of the specified cells, the
data overflows into additional rows and columns.
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* edat must not include the cell that contains the MLGetMat rix function. In other
words, be careful not to overwrite the function itself. Also make sure there is enough
room in the worksheet to write the matrix contents. If there is insufficient room, the
function generates a fatal error.

* MLGetMatrix function does not automatically adjust cell addresses. If edat is an
explicit cell address, edit it to correct the address when you do either of the following:

* Insert or delete rows or columns.
* Move or copy the function to another cell.

» If worksheet calculation mode is automatic, MLGetMatrix executes when you enter
the formula in a cell. If worksheet calculation mode is manual, enter the
MLGetMatrix function in a cell, and then press F9 to execute it. However, pressing
F9 in this situation may also execute other worksheet functions again and generate
unpredictable results.

» Ifyou use MLGetMatrix in a macro subroutine, enter MatlabRequest on the line
after the MLGetMatrix. MatlabRequest initializes internal Spreadsheet Link
variables and enables MLGetMatrix to function in a subroutine. Do not include
MatlabRequest in a macro function unless the function is called from a subroutine.

See Also
MLAppendMatrix | MLPutMatrix | MLPutRanges

Topics

“Create Diagonal Matrix Using Microsoft Excel Ribbon” on page 1-18

“Create Diagonal Matrix Using Microsoft Excel Context Menu” on page 1-21

“Create Diagonal Matrix Using Worksheet Cells” on page 1-25

“Create Diagonal Matrix Using VBA Macro” on page 1-28

“Find and Execute MATLAB Function Using MATLAB Function Wizard” on page 1-30
“Executing Spreadsheet Link Functions” on page 1-42

Introduced before R2006a
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MLGetVar

Write contents of MATLAB matrix in Microsoft Excel VBA variable

Syntax

MLGetVar ML var name, VBA var name

Description

MLGetVar ML var name, VBA var name writes the contents of MATLAB matrix
ML var name in the Excel Visual Basic for Applications (VBA) variable VBA var name.
Creates VBA var name if it does not exist. Replaces existing data in VBA var name.

Input Arguments

ML_var_name

Name of MATLAB matrix to access.

ML var name in quotes directly specifies the matrix name. ML _var name without quotes
specifies a VBA variable that contains the matrix name as a string. Do not use the

MATLAB variable ans as ML _var name. If defined, ML var name must be of type
VARTIANT. Any other type will give a "TYPE MISMATCH" error.

VBA_var_name
Name of VBA variable where the function writes the contents of ML_var name.

Use VBA var name without quotes.

Examples
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Write the Contents of a MATLAB Matrix into a VBA Variable

Write the contents of the MATLAB matrix J into the VBA variable Datal:
Sub Fetch()

MLGetVar "J", Datal
End Sub

See Also
MLPutVar

Topics

“Create Diagonal Matrix Using VBA Macro” on page 1-28
“Executing Spreadsheet Link Functions” on page 1-42

Introduced before R2006a
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MLMissingDataAsNaN

Set empty cells to NaN or 0

Syntax

= MLMissingDataAsNaN(flag)
MLMissingDataAsNaN flag
out = MLMissingDataAsNaN(flag)

Description

= MLMissingDataAsNaN(flag) sets empty cells to NaN or @. When the Spreadsheet
Link software is installed, the default is "no", so empty cells are handled as 0s. If you
change the value of MLMissingDataAsNaN to "yes", the change remains in effect the
next time a Microsoft Excel session starts. Use this syntax when working directly in a
worksheet.

MLMissingDataAsNaN flag sets empty cells to NaN or 0. Use this syntax in a VBA
macro.

out = MLMissingDataAsNaN(flag) lets you catch errors when executing

MLMissingDataAsNaN in a VBA macro. If MLMissingDataAsNaN fails, then out is a
string containing error code. Otherwise, out is 0.

Input Arguments

flag
Either "yes" or "no".
Specify "yes" to set empty cells to use NaNs. Specify "no" to set empty cells to use 0s.

Default: "no"
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Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Set Empty Cells to Use 0s

Cancel the use of the value NaN for empty cells:

=MLMissingDataAsNaN("no")

Tips

* A string in an Excel range always forces cell array output and empty cells as NaNs.

See Also
MLPutMatrix

Introduced in R2007a
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MLOpen

Start MATLAB

Syntax

= MLOpen()
MLOpen
out = MLOpen()

Description

= MLOpen() starts MATLAB process. Use MLOpen to restart the MATLAB session after
you have stopped it with MLClose in a given Microsoft Excel session. Use this syntax
when working directly in a worksheet.

MLOpen starts MATLAB process. Use MLOpen to restart the MATLAB session after you
have stopped it with MLClose in a given Microsoft Excel session. Use this syntax in a VBA
macro.

out = MLOpen() lets you catch errors when executing MLOpen in a VBA macro. If
MLOpen fails, then out is a string containing error code. Otherwise, out is 0.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Start a MATLAB Session

Start a MATLAB session from a worksheet:
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MLOpen()

Tips
» If a MATLAB process has already started, subsequent calls to MLOpen do nothing.

* To start a MATLAB session and initialize the Spreadsheet Link software, use
matlabinit rather than MLOpen.

See Also
MLClose | matlabinit

Introduced before R2006a
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MLPutMatrix

Create or overwrite MATLAB matrix with data from Microsoft Excel worksheet

Syntax

= MLPutMatrix(var _name, mdat)
MLPutMatrix var name, mdat
out = MLPutMatrix(var _name,mdat)

Description

= MLPutMatrix(var_name, mdat) creates or overwrites matrix var name in MATLAB
workspace with specified data in mdat. Creates var name if it does not exist. Use this
syntax when working directly in a worksheet.

MLPutMatrix var name, mdat creates or overwrites matrix var name in MATLAB
workspace with specified data in mdat. Use this syntax in a VBA macro.

out = MLPutMatrix(var name,mdat) lets you catch errors when executing

MLPutMatrix in a VBA macro. If MLPutMatrix fails, then out is a string containing
error code. Otherwise, out is 0.

Input Arguments

var_name
Name of MATLAB matrix to create or overwrite.

var_name in quotes directly specifies the matrix name. var name without quotes
specifies a worksheet cell address (or range name) that contains the matrix name.

mdat

Location of data to copy into var_name.
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mdat must be a worksheet cell address or range name. Do not enclose it in quotes.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Create or Overwrite a Matrix in the MATLAB Workspace

Create or overwrite matrix A in the MATLAB workspace with the data in the worksheet
range A1:C3:

MLPutMatrix "A", Range("Al:C3")

Import Data from a Microsoft Excel Worksheet to the MATLAB Workspace Using
the putmatrix Toolbar Button

1 In the Excel worksheet, select the columns and/or rows you want to export to the
MATLAB workspace.

Eid9--is

Home Insert Page Layout Formulas Data

startmatlab |putmatrix getmatrix evalstring getfigure wizard preferences

Custom Toolbars

3 1 2 3
4 4 3 5]

| ]
5



MLPutMatrix

2 Click the putmatrix button on the Spreadsheet Link toolbar. A window appears that
prompts you to specify the name of the MATLAB variable in which you want to store
your data.

Microsoft Excel @

Variable name in MATLAB
Cancel

-

3 Enter newmatrix for the MATLAB variable name.
4 Click OK.

Now you can manipulate newmatrix in the Command Window.

newmatrix
newmatrix =
1 2 3
4 5 6

Tips
+ If var_name exists, this function replaces the contents with mdat.

* Empty numeric data cells within the range of mdat become numeric zeros within the
MATLAB matrix identified by var name.

» If any element of mdat contains string data, mdat is exported as a MATLAB cell array.
Empty string elements within the range of mdat become NaNs within the MATLAB cell
array.

* When using MLPutMatrix in a subroutine, indicate the source of the worksheet data
using the Microsoft Excel macro Range. For example:

Sub test()
MLPutMatrix "a", Range("Al:A3")
End Sub
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If you have a named range in your worksheet, you can specify the name instead of the
range; for example:

Sub test()
MLPutMatrix "a", Range("temp")
End Sub

where temp is a named range in your worksheet.

See Also
MLAppendMatrix | MLGetMatrix | MLPutRanges

Topics

“Create Diagonal Matrix Using Microsoft Excel Ribbon” on page 1-18

“Create Diagonal Matrix Using Microsoft Excel Context Menu” on page 1-21

“Create Diagonal Matrix Using Worksheet Cells” on page 1-25

“Create Diagonal Matrix Using VBA Macro” on page 1-28

“Find and Execute MATLAB Function Using MATLAB Function Wizard” on page 1-30
“Executing Spreadsheet Link Functions” on page 1-42

Introduced before R2006a
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MLPutRanges

Send data in Microsoft Excel named ranges to MATLAB

Syntax

= MLPutRanges()

MLPutRanges
out = MLPutRanges()

Description

= MLPutRanges () writes the named cell ranges in a Microsoft Excel worksheet into
MATLAB variables. The variables are named with the same name specified by the cell
range name in Microsoft Excel. To use this syntax, right-click in any Microsoft Excel cell,
enter this syntax, and press Enter.

MLPutRanges writes the named cell ranges in a Microsoft Excel worksheet into MATLAB
variables. The variables are named with the same name specified by the cell range name
in Microsoft Excel. Use this syntax when working directly in a Microsoft Visual Basic
macro.

out = MLPutRanges () returns the named cell ranges in a Microsoft Excel worksheet
into MATLAB variables. The variables are named with the same name specified by the cell
range name in Microsoft Excel. In this case, out specifies whether the MLPutRanges
function executed successfully. Use this syntax when working directly in a Microsoft
Visual Basic macro.

Examples
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Export Microsoft Excel Named Range to MATLAB in Microsoft Excel Cell
Define a name for a range of cells from cell A1 through cell E1. For instructions about
defining names, see Excel Help and enter the search term: define and use names in
formulas.

The name of the range of cells testData appears in the Name Box.

l‘f | ™
X d9- |= Bookl - Microsoft Excel ﬂ‘éj
Home | Insert | Page Layc | Formulas | Data | Review | View | Develope | Add-Ins | & a o @ ER

'—j & Calibri Y - = =25 v, Al T - 47~ ‘l
= x| B 5 U - s rad v - -
Faste el n A A Number| Styles | Cells E #
. Hie | My A~ APar - - - - -
Clipboard ra Faont ] - Editing MATLAB
testData - A
A | 8 | ¢ | o | E F G H 1L B
1 1 2 3 4 3 %
2
3 w
4 4 » M| Sheetl Sheet?  Sheet3 . #J |I|1| il | b m
Ready | B3 | Average:3 Count:5 sum:15 |[EE|E1E0 1003 (=) [ {+)

e A

To send data in the named range in the current worksheet to MATLAB, execute the
function inside a worksheet cell.

= MLPutRanges()
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=

| = e o= EE]

Home Insert | Page Layc | Formulas | Data | Review | View | Develope | Add-Ins | & 9 o E3

- |5 Bookl - Microsoft Excel

B T - SsE=g X v AT
e R Soor e E R 4
Paste N ) Mumber| Styles | Cells
- B ] A E - - - 2 ~
Clipboard ra Fant Alignment Editing MATLAE
SUM - KV fr| =mlputranges() >
A B C D E F ] H [~
1 1 2 3 4 5 E
2 =mlputranges(}
3 -
4 4 » M| Sheetl Sheet? ~Sheetd ¥J 4] il | [
Edit | B3 | | BB O B 100%

After pressing Enter, Microsoft Excel exports the named range testData to the
MATLAB variable testData in the MATLAB workspace.

Command Windoaw ® | | Workspace ®
@ Meww to MATLABT Wifatch this Video, see Exarnples, orre | Mame = Walue Min ERS
> teatData HatestData [1,2,3,4,5] 1 5

testDhata =

Export Microsoft Excel Named Ranges to MATLAB in Microsoft Visual Basic Macro

Without Output

Call the function to send data in the named ranges in the current worksheet to MATLAB.

MLPutRanges
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Export Microsoft Excel Named Ranges to MATLAB in Microsoft Visual Basic Macro
with Output

Call the function to send data in the named ranges in the current worksheet to MATLAB.
out = MLPutRanges()

out returns 0 if the function succeeded or a string with the corresponding error code if
the function failed.

Output Arguments

out — Status
0 | string

Status for execution of MLPutRanges, returned as 0 if the function succeeded, or a string
containing an error code.

See Also
MLGetMatrix | MLPutMatrix

Topics

“Create Diagonal Matrix Using Microsoft Excel Ribbon” on page 1-18

“Create Diagonal Matrix Using Microsoft Excel Context Menu” on page 1-21

“Create Diagonal Matrix Using Worksheet Cells” on page 1-25

“Create Diagonal Matrix Using VBA Macro” on page 1-28

“Find and Execute MATLAB Function Using MATLAB Function Wizard” on page 1-30
“Executing Spreadsheet Link Functions” on page 1-42

Introduced in R2013b
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MLPutVar

Create or overwrite MATLAB matrix with data from Microsoft Excel VBA variable

Syntax

MLPutVar ML var name, VBA var name
out = MLPutVar ML var name, VBA var name

Description

MLPutVar ML var name, VBA var name creates or overwrites matrix ML var name
in MATLAB workspace with data in VBA var name. Creates ML var name if it does not
exist. IfML var name exists, this function replaces the contents with data from

VBA var name.

out = MLPutVar ML var name, VBA var_ name lets you catch errors when executing

MLPutVar. If MLPutVar fails, then out is a string containing error code. Otherwise, out
is 0.

Input Arguments

ML_var_name
Name of MATLAB matrix to create or overwrite.

ML var name in quotes directly specifies the matrix name. ML var name without quotes
specifies a VBA variable that contains the matrix name as a string.

VBA_var_name
Name of VBA variable whose contents are written to ML_var_name.

Use VBA var_ name without quotes.
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Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Create a MATLAB Matrix Using Data Stored in a VBA Variable

Create (or overwrite) the MATLAB matrix K with the data in the VBA variable DatakK:

Sub Put()
MLPutVar "K", DataK
End Sub

Tips
* Use MLPutVar only in a macro subroutine, not in a macro function or in a subroutine

called by a function.

* Empty numeric data cells within VBA var_ name become numeric zeros within the
MATLAB matrix identified by ML _var_name.

+ If any element of VBA var name contains string data, VBA var_ name is exported as
a MATLAB cell array. Empty string elements within VBA var name become NaNs
within the MATLAB cell array.

See Also
MLGetVar

Topics
“Create Diagonal Matrix Using VBA Macro” on page 1-28
“Executing Spreadsheet Link Functions” on page 1-42

Introduced before R2006a



MLShowMatlabErrors

MLShowMatlabErrors

Return standard Spreadsheet Link errors or full MATLAB errors

Syntax

= MLShowMatlabErrors(flag)
MLShowMatlabErrors flag

Description

= MLShowMatlabErrors(flag) sets the error message type when executing MATLAB
commands using MLEvalString in Microsoft Excel. An error displays when
MLEvalString fails. You can display two different types of error messages. At any point,
you can switch between displaying Spreadsheet Link and MATLAB errors. Without this
function, worksheet cells display only Excel error messages. Use this syntax when
working in a worksheet cell.

MLShowMatlabErrors flag works in a VBA macro.

Examples

Display Spreadsheet Link Errors in Worksheet Cell

This Spreadsheet Link code assumes MLEvalString returns MATLAB errors upon
failure.

Enter this text in any worksheet cell to display MLEvalString failures as Spreadsheet
Link errors.

=MLShowMatlabErrors("no")

Enter this invalid text in any worksheet cell.

=MLEvalString("sum(2+b);")
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This Spreadsheet Link error appears in the calling cell.

#COMMAND !

Display MATLAB Errors in VBA Macro
This VBA code assumes MLEvalString returns Spreadsheet Link errors upon failure.

Enter this text at the beginning of a VBA macro to display MLEvalString failures as
MATLAB errors.

MLShowMatlabErrors "yes"

Enter this invalid text in the VBA macro.

out = MLEvalString("sum(2+b);")
MsgBox (out)

When running this macro, this MATLAB error appears in a dialog box: ??? Undefined
function or variable 'b'. For details on running macros, see Excel Help.

Input Arguments

flag — Error message indicator
“no" (default) | "yes"

Error message indicator, specified as "no" or "yes" to determine the type of error
message displayed when MLEvalString fails. To display the standard Spreadsheet Link
errors, specify "no". To display the full MATLAB errors, specify "yes".

See Also
MLEvalString

Topics

“Create Diagonal Matrix Using Worksheet Cells” on page 1-25
“Create Diagonal Matrix Using VBA Macro” on page 1-28
“Executing Spreadsheet Link Functions” on page 1-42



MLShowMatlabErrors

“Worksheet Cell Errors” on page 3-2
“Microsoft Excel Errors” on page 3-6

Introduced in R2006b
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MLStartDir

Specify MATLAB current working folder after startup

Syntax

= MLStartDir(path)
MLStartDir path
out = MLStartDir(path)

Description

= MLStartDir(path) sets the MATLAB working folder after startup. Use this syntax
when working directly in a worksheet.

MLStartDir path sets the MATLAB working folder after startup. Use this syntax in a
VBA macro.

out = MLStartDir(path) lets you catch errors when executing MLStartDir in a VBA

macro. If MLStartDir fails, then out is a string containing error code. Otherwise, out is
0.

Input Arguments

path

Path to the new MATLAB working folder after startup.

Output Arguments

out

Execution status that contains 0 if the command succeeded. Otherwise, out contains a
string with an error code.



MLStartDir

Examples

Specify MATLAB Working Folder

Set the MATLAB working folder to d:\work after start up in a worksheet cell.

=MLStartDir("d:\work")

Specify MATLAB Working Folder That Includes Spaces

If your folder path includes a space, embed the path in single quotation marks within
double quotation marks.

Set the MATLAB working folder to d: \my work in a VBA macro.

MLStartDir "'d:\my work'"

Specify MATLAB Working Folder with Execution Status

Set the MATLAB working folder to d: \work after start up in a VBA macro. Return the
execution status out.

out = MLStartDir("d:\work")

Tips

» This function does not work like the standard Microsoft Windows Start In setting,
because it does not automatically run startup.mor matlabrc.m in the specified
folder.

* The working folder changes only if you run MATLAB after you run this function.
Running this function while MATLAB is running does not change the working folder
for the current session. In this case, MATLAB uses the specified folder as the working
folder when it is restarted.
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See Also
MLAutoStart

Introduced in R2006b
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MLUseCellArray

Toggle MLPutMatrix to use MATLAB cell arrays

Syntax

= MLUseCellArray(flag)
MLUseCellArray flag
out = MLUseCellArray(flag)

Description

= MLUseCellArray(flag) specifies whether MLPutMatrix must use cell arrays for
transfer of data (for example, dates). When the Spreadsheet Link software is installed, the
default is "no". If you change the value of MLUseCellArray to "yes", the change
remains in effect the next time a Microsoft Excel session starts. Use this syntax when
working directly in a worksheet.

MLUseCellArray flag specifies whether MLPutMatrix must use cell arrays for
transfer of data. Use this syntax in a VBA macro.

out = MLUseCellArray(flag) lets you catch errors when executing

MLUseCellArray in a VBA macro. If MLUseCellArray fails, then out is a string
containing error code. Otherwise, out is 0.

Input Arguments
flag
Either "yes" or "no".

Specify "yes" to automatically uses cell arrays for transfer of data structures. Specify
"no" to stop using cell arrays for transfer of data structures.

Default: "no"
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Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Stop Using Cell Arrays When Transferring Data Structures

Cancel automatic use of cell arrays for easy transfer of data:

MLUseCellArray("no")

See Also
MLPutMatrix

Introduced in R2007a
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MLUseFullDesktop

Specify whether to use full MATLAB desktop or Command Window

Syntax

= MLUseFullDesktop(flag)
MLUseFullDesktop flag
out = MLUseFullDesktop(flag)

Description

= MLUseFullDesktop(flag) sets the MATLAB session to start with the full desktop or
Command Window only. Use this syntax when working directly in a worksheet.

MLUseFullDesktop flag sets the MATLAB session to start with the full desktop or
Command Window only. Use this syntax in a VBA macro.

out = MLUseFullDesktop(flag) lets you catch errors when executing

MLUseFullDesktop in a VBA macro. If MLUseFullDesktop fails, then out is a string
containing error code. Otherwise, out is 0.

Input Arguments
flag
Either "yes" or "no".

Specify "yes" to start full MATLAB desktop. Specify "no" to start the Command Window
only.

Default: "yes"
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Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Start Only the Command Window

Set the MATLAB session to start with the command window only:

MLUseFullDesktop("no")

See Also
MLClose | MLOpen | matlabinit

Introduced in R2006b



